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1 2 3  

 
 

        
 تفاصيــل المفردات الأسبــــــــــــــــــــــــوع

,تشغيله, وصف  Internet, مفهوم الأنترنيت  Networksمفهوم الشبكات  1-3
, الأستفادة (web)ومكوناتها , كيفية الأتصال مع الشبكة العالمية  الشاشة الرئيسية

, التعرف على طرق Yahoo, Goggleمن محركات البحث المشهورة مثل 
 البحث عن المعلومات والوصول اليها .

, التعرف على مفهوم البرنامج : فوائده , مواصفاته  وميزاته  Excelبرنامج  4-10
ومكوناتها واحتوائها على مختلف سية الشاشة الريئى وطرق تشغيله , التعرف عل

 , مفهوم الخلية , أنواع البيانات الأساسية وكيفية أدخالها .القوائم والأدوات الفعالة 
, أغلاق   workbookأو  worksheetكيفية حفظ صفحة  العمل 

ات البرنامج وأغلاق الملف , فتح الملف المحفوظ , أدخال البيانات وأجراء العملي
الحسابية البسيطة , التعرف على أو كيفية ضبط  أو تنسيق البيانات وهيكلتها ضمن 

 الخلية الواحدة أو مجموعة الخلايا .
التعرف عى طرق جمع البيانات أو مجموعة الخلايا بصورها  المختلفة وكذلك 

 كيفية فرز البيانات .
 Min, Max,sum,Aveالتي يوفرها البرنامج مثل  استخدام بعض الدوال
,Sort,Count وغيرها من الدوال الأحصائية المفيدة ذات العلاقة ز 

التي يوفرها البرنامج , كيفية نسخ البيانات  Editingالتعرف الى عملية التنقيح 
وقطعها ,والتعرف على عملية نسخ العمليات الحسابية وكذلك مفهوم الخلاىيا النسبية 

reative  والخلايا المطلقةAbsolute . 
التحكم في عرض الخلية : التحكم في عرض الخلية تغيير نمطها ونسقها من خلال 

 أستخدام ادوات التنسيق ,
وكيفية تحويل البيانات الرقمية والنصية الى  Chart_ التعامل مع المخططات 

 Chart Wizardمخططات بمختلف أنواعها من خلال ساحر المخططات 
 والتنقيحات التي يوفرها البرنامج .والتعرف على كيفية أجراء التعديلات 

اضافة أو حذف الصفوف والأعمدة في صفحة العمل وكيفية _ التعرف على كيفية 
 طباعة البينات الرقمية أو المخططات .

 : مفهوم البرنامج وتشغيله . SPSSالبرنامج الأحصائي  11-20
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 خطوات تحليل البيانات والتعرف على مكونات الشاشة الرئيسية . -
 خال البيانات وحفظها واسترجاعها , أنواع البيانات وفرزها وتبديلها زاد -
ودمج الملفات وتحليلها ,  Caseأو حالة  Variableأدراج متغير  -

  Non-parametricأجراء الأختبارات اللامعلمية 
 

 تفاصيــل المفردات الأسبــــــــــــــــــــــــوع
21-30 Body Works )تي تعمل تحت بيئة النسخة القديمة الDos أو

Windows  , (-  , مفهوم البرنامج , طرق تشغيله ,الخروج منه
ى الشاشة الرئيسية والأستفادة من الخيارات التي توفرها والتي التعرف عل

تمثل أجهزة جسم الأنسان المختلفة للأقسام العامة والخاصة مثل : الجهاز 
 Nervous System ,Skeletal,Digestiveالعصبي 

,Muscieُ,Endocrineوغيرها , 
التعرف من خلال النظام أيضا" على معلومات حول الصحة  -

وأنواعها  Drugsالعامة , الأسعافات الولية , المواد المخدرة  
وطرق الوقاية منها , الجروح التي تصيب الرياضيين , ونقص 

 .(Aids)المناعة المكتسبة 
ية الوصول الى التعامل مع الفأرة من خلال الابرنامج وكيف -

 الصور التوضيحية والشرح الخاص بكل تأشير على جسم الأنسان 
ذات   (PCX)التعامل مع طبع الصور أو تحويلها الى صيغة  -

الضغط العالي من حيث الحجم والتعرف على المواضيع ذات 
التي يوفرها والمساعدة أو البحث  (See also)العلاقة 

 البرنامج .
التي يوفرها  (Animation)ركة الأستفادة من برامج الح -

 البرنامج .
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 الأسبوع الثالث –الأسبوع الأول          
 

 -:ما المفصود بشبكة الأنترنيت           
 لم يعد أحد يسمع بشبكة الأنترنيت وهناك الكثير ممن أستخدموها وهنال الأكثر ممن يتمنون أستخدامها         
 حت شبكة الأنترنيت شريان الحياة لكثير من المؤسسات التي تستخدمها وتعتمد عليها في تبادل     وقد أصب         
 .المعلومات         
 التي تقدمها ؟ وكيف نستخدمها ؟ فما هي هذه الشبكة ؟ وما الخدمات         
        

 عضها والموزعة في جميع أنحاء وصولة مع بمالعبارة عن شبكة واسعة من الحواسيب شبكة الأنترنيت :      
 العالم وتخزن كم هائل من المعلومات بأشكال مختلفة مثل النصوص وملفات الصوت ,                            
 والرسومات المتحركة , هذه المعلومات تشمل كافة مناحي المعرفة من علوم وتكنلوجبا                           

 وصحافة  وأعمال وألعاب .                          
 

 سيبم خاصة ( بروتوكولات) للتحكم  بعمليات نقل المعلومات وكمية وتستخدم شبكة الأنترنيت مرا          
 :المعلومات           

  
          (Transmission Control Protocol/ Internet Protocol)  

 
 

 البروتوكولات:     
 تعريفه لغويا" على أنه مجموعة من القواعد التي تنظم التفاهم والتعامل بين كيانين أو نظامين  (                     

 مختلفين من حيث البيئة وأسلوب العمل والتعامل معه .)                      
 تكوين هي برامج وفرتها شركة مايكروسوفت لغرض ربط  الشبكات فيما بينها ل (Web)تعريفه بالنسبة لل        
 شبكة الأنترنيت وهي بشكل عام ثلاثة أنواع :       

 . ( FTP:- File Transfer Protocol)بروتوكول نقل الملفات 1- 
 .( Http:- Hyper Text File Protocol)برتوكول نقل النص الفائق  -2

 رسومات أو صور أو ألوان . والمقصود بالنص الفائق الذي يحتوي بضمنه    
 وهو الأكثر أستخدام ويوفر خدمة راقية . ( WWW. World Wide Web)برتوكول  -3

 
 

 عد الخدمة الأوسع أستخداما" في وقتنا الحاضر وسوف نعرف ماذا تعني والتي ت  (WWW) خدمة          
                  (web)  وما الوسائل التي يمكن الوصول الى(WEB) تعامل مع صفحاته ومواقعه .وكيف ن 
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 مهمة في الأنترنيت : تعريفات              
 وهي عبارة عن وسيلة  ( World Wide Web)هي أختصار للكلمات : (WWW)الويـب  •

 تسهل الوصول الى المعلومات في الأنترنيت فهي أشبه بنافذة نطل منها على                                
 (HTMIL)بلغة أو رموز تسمى عبارة عن صفحات تكتب الأنترنيت فهي                               
 .Browserيمكننا عرضها في حاسوبنا الشخصي بواسطة برنامج يسمى                               

 
 
 وبمجرد تعلم هذا هو برنامج يعرض لك المعلومات الموجودة في الأنترنيت :  Browserالمتصفح  .          

 :نستطيع أن نتنقل في فضاء عالم الأنترنيت ومن أشهر المتصفحات هي البرنامج              
            ( Internet explorer , Mozilla Firefox , Google chrome)   

 
 رفكلما زاد رقم الأصدار كلما أعتبوتتوافر هذه البرامج بعدة أصدارات   وغيرها من المتصفحات .            

 يثا" ومطورا" عن الذي سبقه وفي كل سنة تطرح الشركات أصدارات مطورا" لهذه الأصدار حد            
 المتصفحات .            

 
           

 هو موقع على الأنترنيت يستخدم برنامج خاص : (Search Engines)محرك البحث  .                  
 أشهر هذه المواقع : للبحث عن المعلومات في شبكة الأنترنيت ومن                   
                 (Yahoo .com , Google.com ,Google .ae)     

           . Download:  هو عملية أنزال البرامج من الأنترنت الى الكمبيوتر. 
           . upload . هو عملية نقل الملفات والصفحات من الكمبيوتر الى موقع ما في الأنترنيت : 
           . chat  :. يعني الدردشة أو الحوار المباشر 

           . Hotmail  :يب ( نذكر أن بريد الكتروني عن طريق استخدام الو هو موقع لشركة شهيرة قدمت أول 
 ليس مصطلحا" من مصطلحات الأنترنيت ) . Hotmailال                                   

 
          
         

 من المسؤول عن شبكة الأنترنيت ؟                 
 تحتوي على مهندسين ومحللين ومختصي شبكات تشرف أشراف  (ISCO )هناك جمعية وهي -        
 وتقوم بتطوير برامجيات الشبكة وبدون مقابل .علمي  على شبكة الأنترنيت             
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 خدمات الأنترنيت :                  
 : وهو نظام برمجي يعمل على شبكة الأنترنيت يتكون من مجموعة كبيرة  من (www)خدمة ال 1-
 المكونة من كم هائل من المستندات المتصلة والمتشعبة . (Hypertext)النصوص الحية     

 نظام لتبادل الرسائل والملفات بين الأشخاص . (E-mail)البريد الألكتروني  -2            
 : وهي عبارة  (news group &mailing lists)د البريدية الأختبار والمسار مجموعة -3            

 عن منتديات الكترونية معقدة لتبادل المعلومات حول موضوع معين .                
 : نظام لنقل الملفات من موقع الى آخر ويوفر هذا البروتوكول مكتبة FTPبروتوكول نقل الملفات  -4            

 الكترونية  كبيرة جدا" .                 
 : نظام يتيح أمكانية التحدث الى الآخرين باستخدام الكلمات المكتوبة (Chatting)المخاطبة ال  -5             

 سطة لوحة المفاتيح الى شخص آخر يجلس وراء جهاز حاسوبه امن خلال أرسال الرسالة المكتوبة بو                  
 بانتظار وصول هذه الرسالة والذي يقوم بدوره بالرد عليها مباشرة .                  

 
 

 ان تصبح جزءا" من شبكة الأنترنيت فما عليك سوى أن  أذا أردتنترنيت :  متطلبات الربط أو الأتصال بالأ        
 يكون لديك ما يلي :                                                         

 .جهاز الحاسبة 1-    
 لا بد من وجود مودم متصل بجهاز الكمبيوتر وظيفته ترجمة البيانات من : (Modem)مودم  -2   

 )(Analogالى   (Digital)(( وظيفة المودم تحويل الأشارة لغة الى لغة الكمبيوتر الرقمية  أي     
 وبالعكس .                    

                  
 خطوط نقل الأشارة من مكان الى آخر عبر مسافات معينة بين أجهزة الكمبيوتر والمقصود بخطوط  -3                

 النقل خط أشترك بالأنترنيت .                    
 
 

  ما هي أنوع الأتصال بالأنترنيت :                  
 . (Tcp/ Ip)أي يتصل المستخدم مباشرة بشبكة  -الأتصال المباشر : 1-
 PPPالأتصال الهاتفي تسمى هذه الطريقة  (Dial –up)الأتصال غير المباشر  -2

     (Point to Point Protocol) هذا النوع من الأتصال يتم أستخدام الهاتف لتأمين 
 الأتصال بين جهازالمستخدم بواسطة المودم وتقوم شركة خدمة الأنترنيت بوصل المستخدم      
 بشبكة الأنترنيت .     
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 وسلبياتها : مميزات شبكة الأنترنيت
 

 يزودنا الأنترنيت بكمية هائلة من الوثائق والمعلومات المنظمة والمبوبة في مختلف 1- 
 مخزونة في عشرات الألوف من شبكات المعلومات والمسترجعة عبر الموضوعات والمجالات                        
 الحواسيب المنتشرة في دول العالم الثالث .ملايين                        

 تمثل أخترقا" وأختفاء للحدود الجغرافية والسياسية للدول والأقاليم والقارات وتحويل العالم  -2                   
 الى قرية صغيرة من خلال شاشة حاسوب ومعدات سهلة الأستخدام .                       

 أتصال آلي وفوري مباشر لمواقع وشبكات مختلفة بكلف نداء هاتفي محلي . يلةوس -3                   
 ماتي عند المستخدمين وتطوير المجتمعات من خلال نشرالوعي المعلو تعمل على تثقيف -4                   

 البحثية وتعاملهم مع مختلف أنواع المعلومات . أمكاناتهم                       
 سهولة الأرتباط بالشبكة من خلال الأنواع المختلفة من الحواسيب المصنعة في العالم وخاصة  -5                  

 الشخصية .الحواسيب                       
 يد ملف أو وثيقة والحصول عليها بدقة وبأقل وقت ممكن في الغالب .دأمكانية تح -6                   
 ير البرامج والبروتوكولات وأدوات الأتصال المساعدة والمناسبة التي تطورت من خلال توف -7                   

 الشبكة وكذلك  الأدلة الأرشادية المساعدة لها .                       
 الشبكة والأستفادة من معلوماتها على شريحة محددة من أبناء المجتمع بل جميعهم  عمللا يقتصر -8                  

 تقريبا" ( الطلبة والتدريسيون وأصحاب الأعمال وشخصيات الأعمال والسياسة والفنيون                        
 وأصحاب الهوايات) .                       

 
  

  كيف يعمل الأنترنيت ؟:            
 ماذا يحدث عندما تطلب موقع على الأنترنيت ؟ ...              

 الى ثلاثة أقسام : URLبتقسيم عنوان الموقع  يقوم متصفحك1- 
 . HTTpالأول : البرتوكول 

 .WWW.c4ARABالثاني : أسم السير فر 
 . INDEX.HTMLالثالث : أسم الملف 

 DNS (DOMAIN NAME SERVERS)تصال بخادم  الأسماء المتصفح يقوم بالأ -2
 المطلوب للأتصال بجهاز  IPالى عنوان  WWW.C4ARAB.comع لتحويل أسم الموق     
 . SERVERالخادم ٍ      
 . 80على البورت  IPيقوم المتصفح بالأتصال برقم الآي بي  -3
 طالبا" SERVERيقوم المتصفح بأرسال طلب الى الخادم  HTTPبأتباع البروتوكول  -4

 . WWW.C4ARAB.com/INDEX.HTMLلملف منه ا     
 الى متصفحك . TXTبأرسال ملف  SERVERيقوم الخادم  -5
 ويقوم بعرض  SERVERالمرسل من قبل الخادم  TXTيقوم المتصفح الآن بقراءة ملف  -6

 .الصفحة على شاشة حاسوبك     
  
 

http://www.c4arab/
http://www.c4arab.com/
http://www.c4arab.com/INDEX.HTML
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 بمواصفات عالية وخاصة متصل بالأنترنيت على طول وتر يهو جهاز كمي: (SERVER)الخــادم 
 الوقت وتخزن فيه الصفحات والملفات الخاصة بالمواقع .( بعض المواقع                                  
 ا بقية يكون لها خادم خاص بموقعها فقط وعادة تكون المواقع كبيرة , أم                                 
 المواقع فيكون فيها الخادم مشتركة فيه عدة مواقع وهو الساند بالنسبة للمواقع                                                
 الصغيرة والمتوسطة  .                                 

 ولديك شرح وتوضيح للواجهة التطبيقية للأنترنيت: 
 
 

 
 
 
 
 

 من       (search Engine)يتكون عمل محركات البحث محركات البحث في الأنترنيت :  عمل              
 ثلاث مراحل :                                             

 الذي يبحر في الأنترنيت لأيجاد  (Spider)المرحلة الأولى : تبدأ هذه المرحلة مع برنامج العنكبوت 
 مؤشرات ديدة على الويب والأطلاع على محتوياتها ويأخذ هذا البرنامج صفحات ج                     
 وعناوين هذا الموقع .                    

 المرحلة الثانية : تقوم هذه المرحلة بتوصيف صفحات الويب المختارة وفق مجموعة من المعايير مثل 
 لنتائج في قاعدة بيانات ضخمة .الأكثر تكرارا" من غيرها وتحفظ االكلمات                     

 المرحلة الثالثة : تميز هذه المرحلة محركات عن الدليل أذ يلتقط محرك البحث الأستعلام الذي يقوم 
 ويقارنه مع قاعدة البيانات الموجودة لديه باستخدام خوارزميات المستخدم بتدوينه                     
 نتائج البحث المتمثلة بصفحات الويب التي تطابق استعلام  المطابقة ثم تعرض                    
 المستخدم.                     
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 (.…,Yahoo,google,Hotboot,Acsayt)ومن أشهرالأدلة  ومحركات البحث :
 

---------------------------------------------------------------------------------------- 
نترنيت المصنفة , دون منازع وهو ياهو من أقدم أدلة الأ: يعد (.yahoo.comwww)ياهو

                                         راض المواقع والصفحات الجيدة على الأنترنيت .نقطة أنطلاق جيدة لأستع
 

 : (WWW.GOOGLE.COM)كوكل 
والشائعة الأستعمال على الأنترنيت وللبحث به أطبع بضع كلمات تصف ما  المهمةأحد محركات البحث 

لكي تظهر النتائج على  (SEARCH)أو أنقر على مربع  (ENTER)تبحث عنه واضغط مفتاح 
 شكل نافذة .

 

 
 
 
 
 
 
 
 
 
 
 

 

http://www.yahoo.com/
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 : Google)(ملاحظات حول كوكل                 
 
 

 بحثك ولا حاجة لأي شئ بين الكلمات مات يعطيك كوكل الصفحات التي تحتوي على كل كل1- 
 ليجدها كلها ولتضييق البحث ,زد عدد كلمات البحث .     
 .(COM,http)يتجاهل كوكل الكلمات والأحرف الكثيرة الأستعمال آليا" أشياء أخرى مثل  -2
 يبحث كوكل عن الكلمات كما تظهر في مربع البحث بالتمام فالبحث مثلا"عن كلمة (كتاب) -3
 فلن تكون نتيجة البحث كلمة (كتاب ,مكتوب,مكتب) وأنما تنتج ما يطابق كلمة (كتاب) فقط .    

 عنه كبيرا" أم صغيرا" فجميع الحروف لايأخذ كوكل في الأعتبار كون الحرف اللاتيني الذي يبحث  -4
 كيفما طبعت تفهم على أنها صغيرة .      

 protble Document)ل ملفات من نوع أن نتائج البحث فيه تشممن مميزات كوكل  -5
Format)   مختصرا" تكتب ,PDF)  وهو نوع من الملفات التي تتضمن ملف يتألف من دراسة ( 

 تظهر   (PDF)كاملة لموضوع ما (بحث أو تقرير ) ولكي تعرف نتيجة البحث تتضمن ملف نوع   
 حتاج لبرنامج خاص وهو باللون الأزرق أمام العنوان ولفتح هذا الملف ت ([PDF])علامة  

    (Acrobat Reader Program)  . 
من واجهة  (Image)حث عن الصور بكل سهولة وذلك باختيار صورة بيمكننا في كوكل ال -6

 الأختيار الرئيسية لكوكل .
 
 
 

       ----------------------------------------------------------------------------- 
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 الأسبــوع الرابــع الـى العاشـــــر : 
 

Microsoft Excel : برنامج جداول بيانات يستخدم في تسجيل البيانات وتحليلها ومتابعة  هو 
 التغييرات التي تنجز على تلك البيانات وتعديلها بما يتلائم مع طبيعة                                      

 .Excelأو نوعية البيانات أو المعلومات التي يحتويها ملف                                     
 

 فيها :  Excelما هي أستخدامات وأبواب المعرفة التي يدخل 
 في كتابة التقارير المالية وأنشاء الموازنات وتحليل المعلومات    Excelيستخدم برنامج  -1

 عديدة أهمها أجراء الحسابات وغيرها من المهام الأخرى  أحصائيا" وذلك لأحتوائه على مميزات     
 أوتوماتيكيا".    
 من أنشاء الرسوم أو المخططات البيانية التي توضح العلاقة بين  Excelيمكننا برنامج  -2

 المتغيرات كما يمكن أنشاء المخططات التنظيمية .    
 لمعقدة في أجراء الحسابات أو التعديل .من استخدام الدوال البسيطة وا  Excelيمكننا برنامج  -3
 كبرنامج للطباعة أيضا" وذلك لأحتوائه على الكثير من الأوامر  Excelيمكن أستخدام برنامج  -4

 الخاصة  بالطبع وغيرها من المهام الأخرى .    
 

 هما : أماهناك طريقتان :  Microsoft Excelتشغيل برنامج 
  startقائمة البدء  من لا":وأ 
 
  Start → programs →  Microsoft offic → Microsoft Excel 
 
 

 أو 
 

 ثانيا" : 
     D.LC   on  icon Microsoft Excel       ( on the disktop) 
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 : Excelمحتويـــات نافــــذة           
  Microsoftويحتوي على جهة يساره على أسم البرنامج :  ( title Bar)شريط العنوان  -1           

               Excel  وعلى جهة اليمين لهذا الشريط الأزرار الثلاثة الخاصة بأغلاق البرنامج , تكبير وتصغير 
 النافذة وزر الأغلاق المؤقت .                

 ويحتوي هذا الشريط على مجموعة الأوامر الرئيسية الخاصة ) :  Menu Barوائم ( شريط الق -  2       
  ,File, Edit, View, Insert, Format)وهي : Excelبالتعامل مع برنامج                 
              Tools , Data, Windows, Help ) . 

 من الأشرطة يتم أظهارها أو أخفاؤها حسب  يحتوي على مجموعة :(Tools Bar)شريط الأدوات  -3         
 الحاجة اليها مثل شريط الرسوم البيانية وشريط العمليات الحسابية وغيرها .             

 بأظهار أسم الخلية : يحتوي هذا الشريط على جزء خاص   ( Formula Bar )شريط الصيغ  -4         
 توي على جزء خاص لأدخال البيانات والصيغ الرياضية والرموز ويلاحظ التي يتم التوقف عليها كما يح              
 وجود الرموز التالية عند البدء بأدخال المعلومات :              
 أي أدخال المعلومة التي يتم طبعها وخزنها غي الخلية . Enter(   ) والتي تعني  –أ                
 أي حذف أو مسح المعلومة المطبوعة وعدم خزنها . Cancel ) وهي بمعنى  X(  –ب                
 ( = ) يستخدم هذا الشكل عند كتابة الصيغ الرياضية المختلفة . –ج                

 : هي الجزء أو الحيز المخصص لطبع وخزن المعلومات عليه  ( Work Sheet)ورقـة العمـل  -5         
 قة على مجموعة من التقاطعات تمثل جدولا" كبيرا" وتحتوي على أعمدة           حيث تحتوي هذه الور               
 BAومن  Azالى  AAثم من  Zالى   Aوصفوف ( أسطر) وتسمى الأعمدة حسب الحروف من               
 عمود أما الصفوف فأن  (256)أي أن ورقة العمل تحتوي على  IVيسمى وآخر عمود  BZالى               

 صف أو سطر . (1634 )ورقة  العمل تحتوي على                
 من المهم أظهار هذا الشريط وذلك لكونه يظهر المعلومات   ( Status Bar)شريط الحالة  -6         

 بالأضافة الى  ةالخاصة بالأوامر أو الطريقة التي يتم بواسطتها أي يظهر شرح مبسط للأوامر المختار             
 أظهار بعض العمليات الحسابية السريعة والتي سيتم شرحها  لاحقا" .             
 

 ويحتوي  (Work sheet)كتاب العمل  Excelسمى الملف الخاص بنظام ي1. مـلاحظــــة :           
 حيث يمكن أضافة عدد من أوراق العمل حسب Work sheetعلى أوراق العمل                           

 الحاجة اليها كما سيتم شلرحه لاحقا" .                            
 . xlsيمكن تسمية هذا الملف بأي أسم وتكون الأضافة الخاصة به  -2                           
 . (X)هي حرف  Excelتكون العلامة المميزة على رسم ملفات برنامج  30                           
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 (Row)مع صف أو سطر  (Column)قاطع عمود هي الجزء المتكون من ت:  (Cell)الخليـة              

 في ورقة العمل .                                     
             
 هي الخلية التي يتم أختيارها حيث يظهر أسمها في شريط :   (Active Cell)الخلية النشطة             

 والعمليات حيث تكون جاهزة للعمل عليها وتعديل  الصيغ                                                             
 . محتوياتها                                                               

 :التاليتين يمكن تسمية الخلية بأحد الطريقتينتسميـة الخليـة :                
 .1والصف  Aأي العمود ِ A1ية تسمية الخلية بأسم العمود ثم رقم الصف مثلا" الخل1- 

 . Cوالعمود  3أي الصف  3Cتسمية الخلية أبتداءا" بالصف ثم العمود مثلا"  -2
 

 هو مجموعة من الخلايا المتجاورة أو غير المتجاورة يبدأ عنوان المدى بالخلية العليا بأقصى المـــدى :           
 وينتهي بعنوان الخلية الواقعة في الأسفل والى أقصى  (:)بعلامة  اليسار من المدى متبوعة                         
 . (A1:D3)يمين المدى مثلا" ال                         
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 طـرق الأختيـار ( التظليـل) :           

 
 يتم أختيار خلية واحدة وذلك بالتوقف عليها بواسطة الماوس والنقر عليها بزر الماوسأختيار خلية :1-
 وذلك بالأنتقال من خلية الى   (Keybourd)الأيسر كما يمكن الأختيار بواسطة لوحة المفاتيح      

 . Enterأخرى بواسطة الأسهم ثم الضغط على مفتاح       
 

 يتم ذلك كما يأتي :أختيار مجموعة خلايا متجاورة (المدى) : -2
 .Mouseالضغط على أول خلية ضمن المدى بواسطة ال  -أ  
 الأيسر وسحبه الى أن يصل الى آخر خلية ثم الضغط  Mouseستمرار بالضغط على زر ال الأ -ب 

 عليه مرة أخرى أي أنه يتم تحديد أول خلية وآخر خلية .      
 

 : Excelحدد أو ظلل كل مما يأتي في ورقة العمل لبرنامج تمرين عملي : 
 (A4 , R7 , AD9 , ZA1 , CX50 , T90 , DF77)الخلايا 1-
 {(D6:H16), (C5:G10) , (B1:D1) , (A1:A3 ) }المديات  -2
 

 أختيار عمود أو أختيار أوتظليل صف : -3
 يمكن أختيار عمود بالتوقف بيسار الماوس على أسم العمود وبنفس الطريقة يتم أختيار صف بالنقر      
 على رقم الصف بيسار الماوس .     
 : أختيار مناطق أو مديات غير متجاورة  -4

 أختيار الخلية او المدى الأول بالطرق المشروحة سابقا" . –أ     
 من لوحة المفاتيح بشكل  (Ctrl)لأختيار الخلية الثانية أو المدى الثاني نقوم بالضغط على مفتاح  -ب    

 وب ئنا من تظليل أو تحديد كل المناطق أو الخلايا أو المديات الأخرى المطلامستمر لغاية أنته         
 . نلاحظ بقاء جميع الخلايا  (Ctrl)تظليها   ضمن نفس ورقة العمل ثم نرفع يدنا من مفتاح ال         
 والمديات الغير متجاورة مظللة بالرغم من عدم تجاورها .          

 
 :يتم تظليل ورقة العمل بأحد الطريقتين التاليتين :أو أختيار ورقة العمل  تظليل -5

 .Aوأسم العمود  1ر بيسار الماوس على المربع الفارغ المحصور بين رقم الصف النق -أ       
 .Aومفتاح الحرف  Ctrlباستخدام لوحة المفاتيح وذلك بالنقر وفي آن واحد على مفتاح  -ب       

 
 

 : للخروج من التظليل أو لألغاء التظليل لأي منطقة مظللة على ورقة العمل يتم ذلك بالنقر ملاحظة 
 عندما تكون كل ورقة بيسار الماوس على أية خلية واقعة خارج منطقة التظليل بأستثناء              

 العمل هي المظللة  عندها ننقر بيسار الماوس على أي مكان للخروج من تظليل ورقة العمل              
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 : Excelيأتي في ورقة العمل ببرنامج : ظلل ما تمرين عملي                  
 . Sثم العمود  Gثم العمود   Aالأعمدة 1- 

 . 20ثم  14ثم  3الصفوف  -2
 كل ورقة العمل .  -3
 ظلل المناطق التالية في آن واحد : -4
 . Hو  kوالأعمدة  20و  17و  15مع الصفوف  (A1:D1)مع المدى  B5الخلية   

 التظليل بعد أن يتم التظليل .وفي كل المطاليب أعلاه أخرج من 
 
 

 ( Entering Data)أدخــال البيانـات فـي ورقـة العمـل  :
 

 لأدخال البيانات في ورقة العمل نتبع الخطوات التالية : 
 
 أنقر بيسار الماوس على الخلية المراد أدخال بيانات فيها أو أنقر على مفتاح الأدخال من لوحة 1- 

 المفاتيح على الخلية المراد أدخال بيانات فيها بعد أن تم الأنتقال اليها بواسطة الأسهم .                       
 أدخل البيانات المراد أدخالها من خلال لوحة المفاتيح ( سواء أكانت هذه البيانات نصية أم رقمية  -2                  

 أم  صيغ رياضية )                         
 ) أما بالنقر على الرمز (       ) من شريط الصيغة أو  2ثبت هذه البيانات الدخلة في خطوة(  -3                  

 من لوحة المفاتيح . Enterبالنقر على مفتاح الأدخال                        
               ------------------------------------------------------------------------------------------ 

 
 أدخل البيانات التالية  في الخلايا المؤشرة أزاء كل منها :تمرين عملي :              

 
-1 A1 ← . التسلسل 
2- A2 ← 1 . 
3- A3 ← 2 . 
4- A4 ← 3 . 
5- B1 ← . أسم الطالب 
6- B2 ← . أزهار محمد 
7- B3 ← . وليد عدنان 
8- B4 ← . سمير حامد 
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 )  (Excel Worksheetورقـة عمــل  أكسل :                
 ويحتوي على أورق عمل  Excelعبارة عن ملف في برنامج  Bookالمصنف                    
                  Worksheet  وأوراق تخطيطChart Sheets  وتتكون أوراق العمل من 
 . Columnوالأعمدة  Rowsمجموعة من الصفوف                   

 
 

 .  Excel: سندرس هذة القائمة وما تحتويه من أوامر تعمل في برنامج  File قائمـة
    

 يفتح لك البرنامج ورقة عمل جديدة تلقائيا"  Excel( جديد ) : عند فتح برنامج  newالأمر  1- 
 جديد فأتبع  لبدء بأدخال بيانات أما أذا أردت أنشاء مصنفوما عليك سوى ا                              

 أحد الخطوات التالية :                                    
 وحسب الخطوات العملية التالية :       Fileمن قائمة  أما

File → New → general →Worksheet →ok                

       
  

 
 

 يكونة : وذلك بالنقر بيسار الماوس على شكل الآ  Tools barمن شريط الأدوات   أو
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  Excel: يستخدم هذا الأمر لفتح ملف مخزون  ( محفوظ ) مسبقا" في برنامج  openالأمر  -2
 ويتم ذلك بأحد الطريقتين أعلاه :            

 وحسب الخطوات العملية التالية : Fileمن قائمة  أما      
File → Open → L C on the name folder → Open           

    

                                                                                  
 

 وذلك بالنقر بيسار الماوس على شكل الآيكونة :   Tools barمن شريط الأدوات   أو
          

 
 ) (Book: يستخدم هذا الأمر لغرض أغلاق الملف أو المصنف ( أغلاق )  Closeالأمر  -3
 ويتم ذلك بأحد الطريقتين  مفتوحة , Excelمع بقاء واجهة برنامج                                          

 أمـــــاأدناه :                                           
 :  والخطوة العملية لذلك هي : Fileمن قائمة   - أ

File → Close                                                             
 أو 
 (X)النقر بيسار الماوس على الرمز  : والخطوة العملية لذلك :  Title Bar من شريط العنوان –ب 

 الخاص بنافذة المصنف أو الملف .                                                   
 
 نهائيا" ويتم   Excelرنامج (الخروج ) : يستخدم هذا الأمر للخروج أو لأغلاق ب Exitالأمر  -4

 أمــــــا  ذلك بأحد الطريقتين التاليتين :                                       
 

  File → Exit والخطوة العملية لذلك ::  Fileمن قائمة  –أ                 
 

 لماوس على الرمز والخطوة العملية لذلك :  النقر بيسار ا :   Title Barمن شريط العنوان  –ب    
                                                                (X) . الخاص بنافذة البرنامج الرئيسية 
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 فظ بأسم ) :يستخدم هذا الأمر لحفظ الملف أو المصنف بأسم جديد أنت ( ح  Save Asالأمر  -5   

 ويتم ذلك بأحد  ( Book 1)تختاره  مغاير لأسم المصنف التلقائي                                     
 الطريقتين التاليتين :                                    

  والخطوة العملية لذلك ::   Fileمن قائمة  –أمـــــــــا  :  أ 
File→Save As → Writ  the name file on squre file name→ 

Save   
 

 والطريقة العملية لذلك ::   (tools Bar)من شريط الأدوات  –أو   ب 
                                                                                                                                             

The name file on squre file name→Save               Writ →   
 
 

 ( حفظ) : ويستخدم لحفظ أو خزن بيانات جديدة أضيفت الى بيانات ملف مخزون  saveالأمر  -6        
  بقا"( يستخدم هذا الأمر للحفظ لثاني وثالث مرة  فأكثر لبيانات أضيفت مس                                           
 مخزون مسبقا" ) ويتم ذلك بأستخدام أحد الطريقتيتن التاليتين :لبيانات ملف                                            

          File   :File → Saveمن قائمة  -أمـــــا : أ            
 : :  وذلك بالنقر بيسار الماوس على شكل الآيكونة Tools barمن شريط الأدوات   -أو      : ب            

                                                                                  

                                                                           . 
 

 :  Excelتمريـن  عمـلـي :نفذ ما يأتي في برنامج        
 أدخل البيانات التالية والمتمثلة بأدخال  أربع تسلسلات تحت عنوان  -Excel  ,2أفتح برنامج 1- 

 خل أسماء أربعة طلاب في خلايا وأد A( تسلسل ) في خلايا العمود                                          
 ودرجاتهم في ثلاث مواد دراسية ( صحة مجتمع ,  Bالعمود                                            

 على التوالي . ( C, D , E )حاسبات , دوائيات ) في الأعمدة                                           
 أحفظ البيانات السابقة بأسم ملف وليكن بأسم ( درجات طلابية ) . -3
 خل بيانات جديدة بتسلسل وأسم ودرجات طالب آخر ( خامس )  ودرجاته في المواد أضف أو أد -4

 أعلاه لبيانات الملف السابق .     
 ) الى الملف السابق (4أحفظ الأضافة الجديدة لبيانات الطالب الخامس التي أضفتها في فقرة  -5

 ( درجات طلابية ) .      
 .  Fileئمة أغلق الملف ( درجات طلابية ) من قا -6
 . Fileأفتح الملف (درجات طلابية ) من شريط الأدوات أو من قائمة  -7
 أضف بيانات جديدة لطالب يحمل التسلسل السادس بكافة الحقول التي يحتاجها ثم أحفظ هذه الأضافة  -8
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 على نفس الملف  ( درجات طلابية ) .    
 . Fileمن قائمة  Excelأغلق الملف ثم أغلق برنامج  -9

----------------------------------------------------------------------------------------- 
 ( طبع ) :يستخدم الأمر لطبع  البيانات المدخلة المراد طباعتها ( هذا في حالة كون  Printالأمر  -7

 د الطريقتين التاليتين :الطابعة معرفة على الحاسبة ومربوطة بها كهربائيا" )   ويتم ذلك بأح     
    
      File   :File →Printمن قائمة  –أ أمـا :    
 
 : :  وذلك بالنقر بيسار الماوس على شكل الآيكونة Tools barمن شريط الأدوات   -ب           

                                                                                  
 
 

 عبارة عن برنامج للجداول الألكترونية , Excelبرنامج ) : ( Data Typeأنـواع البيـانات              
 ويستخدم ثلاثة أنواع من البيانات ( الرقمية , النصية , الصيغ                                                               

 الرياضية ) .                                                              
 

 أستخدام الصيغ الرياضية في تحليل البيانات : 
 تستخدم الصيغ الرياضية في تحليل الجداول الألكترونية                                                       

 الحسابية المستخدمة  في والقيام بالعديد من العمليات الحسابية مما يوفر الوقت والجهد , أن العمليات  
 الجداول الألكترونية هي : 

                  
 +       عملية الجمع                     
 عملية الطرح        -                     
 *      عملية الضرب                       

 /        عملية القسمة                      
 ^       الرفع الى أس ( القوة )                     

 
 يجب وضع أشارة ( = ) دائما" قبل البدء بأدخال عملية حسابية للدلالة على القيام بعملية مـلاحـظـة : 
 .         حسابية                

 ل على  ثم أعم بأدخال البيانات الرقمية في أدناه في الخلايا المؤشرة أزاء كل منها  قمتمـريـن عمـلـي :  
 تنفيذ العمليات الحسابية  التالية :                          

                    (A1=2 ,A2=5 , A3=20 , B1=4 , B2= 6 , B3=54 )  
 .A4واضعا" الناتج في الخلية   ( A1, A2 ,A3)أجمع محتوى الخلايا 1-
 .C3واضعا" الناتج في الخلية  B3على محتوى  A3قسم محتوى   -2
 . G1واضعا" الناتج في الخلية  A1محتوى  مع B2أضرب محتوى  -4
 ثم أرفعه للأس (محتوى  B1ثم قسم الناتج على محتوى  B2مع  A3أجمع  -5

 . A10) واضعا" الناتج في الخلية A1الخلية       
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  (Sum Using Equation)أيجاد المجموع باستخدام معادلة المجموع :    

 نضع مؤشر الماوس في الخلية المراد كتابة دالة المجموع فيها .-1ات التالية  : نتبع الخطو       
 أكتب أشارة (=) دلالة على كتابة صيغة رياضية . -2                                    
 متبوعة بأسم المدى الذي يحتوي على البيانات  Sumنكتب دالة  -3                                    

 الرقمية المراد جمعها .                                        
 من لوحة المفاتيح . Enterنضغط على مفتاح الأدخال  -4                                    
                                   ------------------------------------------------------------- 

 
 لجمع البيانات الرقمية في  (C3:D5),(A1:A3)رقمية في المديات  خل بياناتدأعملي :  تمرين    

 و  A5واضعا"ناتج الصيغة في الخلايا  (Sum)المديات أعلاه مستخدما" دالة المجموع                    
                   C5 . على التوالي 

 
 نكتب C5وفي الخلية    sum(A1:A3)=نكتب الصيغة الرياضية   A5في الخلية الحل :   

   sum(C3:D5)=الصيغة الرياضية                 
           -------------------------------------------------------------------------------- 

 : Auto Totalالجمع التلقائي  أيجاد المجموع باستخدام    
    

 نضع مؤشر الماوس في الخلية المراد جمعها . -1نتبع الخطوات التالية  : 

 من شريط الأدوات ننقر على آيكونة الجمع التلقائي  -2                             
                           Tools Bar  . سيظهر خط منقط حول الخلايا التي سيتم أيجاد المجموع لها 

 على مفتاح الأدخال أو ننقر على رمز الجمع التلقائي مرة أخرى ننقر  – 3                             
 لأيجاد ناتج الجمع التلقائي .                                    

 
 أن دالة الجمع التلقائي تستخدم لجمع البيانات الرقمية الواقعة على صف واحد أو عمود واحد ملاحظة : 
 ند أعادة أستخدامها مرة أخرى على نفس الصف أو العمود فأنها تظهر وتعمل مرة واحدة وع                  
                لذلك الصف أو ذلك العمود . نفس ناتج الجمع السابق ألا أذا أضفنا بيانات رقمية جديدة                   

                            
 

 أستخدم دالة الجمع التلقائي (C3:G3),(A1:A3)رقمية في المديات  خل بياناتدأتمرين عملي :  
  C3و  A4لجمع البيانات الرقمية في المديات أعلاه واضعا" ناتج الصيغة في الخلايا                    
 على التوالي .                   

 
                  ----------------------------------------------------------------------------------- 
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 :(Funtion Wizard)أيجاد المجموع باستخدام معالج الدوال      
 نضع مؤشر الماوس في الخلية المراد أيجاد ناتج الجمع فيها . -1نتبع الخطوات التالية  :      

 جودة على شريط الصيغة.ننقر بيسار الماوس على آيكونة معالج الدوال المو-2                                            
  Sumأنقر فوق  (Insert Function)من مربع الحوار الأول  -3                                            

 . OKمن قائمة أختيار الدوال ثم ننقر على مربع                                                   
 

                                         
           

 
 . OKالمراد جمعها باستخدام معالج الدوال ثم ننقرعلى مربع انات الرقمية ينكتب المدى للب -4                      

                                               
                                   

                               
 

 
                         ------------------------------------------------------------------------------ 
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                    / هناك طريقتان / الطريقة الأولى    )  (Minimum Valueحساب القيمة الصغرى                  
 ي الخلية المراد كتابة الصيغة الرياضية .نضع مؤشر الماوس ف -1نتبع الخطوات التالية  :                

 دلالة على كتابة صيغة رياضية . نكتب أشارة (=) -2                                            
 متبوعة بأسم المدى المراد مقارنة بياناته  Minنكتب الصيغة الرياضية  -3                                            

 الرقمية لأيجاد أصغر قيمة عددية فيه .                                                 
 من لوحة المفاتيح لللحصول على ناتج   Enterننقر على مفتاح الأدخال  -4                                            

 المقارنة .                                                
                                ----------------------------------------------------------------------------- 

 
 أكتب صيغة         (C3:G3),(A1:A3)رقمية في المديات  خل بياناتدأتمرين عملي :                           

 حيحة لأيجاد أصغر قيمة رقمية لهذان المديان واضعا" الناتج رياضية ص                                             
 على التوالى : G6و  A5الخلايا في                                              

 ثم ننقر على  Min(A1:A3)=نكتب الصيغة الرياضية  A5الحل : في الخلية                                   
 . Enterمفتاح                                            
 ثم ننقر على  Min(C3:G3)=نكتب الصيغة الرياضية  G6في الخلية                                       

                                . Enterمفتاح                                            
                    ------------------------------------------------------------------------------------ 

 
 وكما يلي : Fx الطريقة الثانية : من معالج الدوال                        

 
 نضع مؤشر الماوس في الخلية المراد كتابة الصيغة الرياضية . -1نتبع الخطوات التالية  :                         

 ننقر بيسار الماوس على آيكونة معالج الدوال الموجودة على شريط  -2                                                      
 الصيغة.                                                          

  Minأنقر فوق  (Insert Function)من مربع الحوار الأول  -3                                            
 . OKمن قائمة أختيار الدوال ثم ننقر على مربع                                                   
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 . OKانات الرقمية المراد جمعها باستخدام معالج الدوال ثم ننقرعلى مربع ينكتب المدى للب -4                     
                                                   

                               
 
 
 
 

 ية للبانات الرقمية المدخلة مسبقا" باستخدام معالج الدوال أوجد أصغر قيمة رقمتمرين عملي :                      
 . A2, واضعا" الناتج في الخلية   (F1:G5)في المدى                                          

 ثم نتبع الخطوات العملية التالية : A2الحل : ننقر بيسار الماوس على الخلية                     
                                                   Fx→all→min→ok→(F1:G5)→ok 

 
                     ------------------------------------------------------------------------------------ 
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                    / هناك طريقتان / الطريقة الأولى    )  (Maximum Valueحساب القيمة الكبرى                    
 نضع مؤشر الماوس في الخلية المراد كتابة الصيغة الرياضية . -1نتبع الخطوات التالية  :                

 دلالة على كتابة صيغة رياضية . نكتب أشارة (=) -2                                            
 متبوعة بأسم المدى المراد مقارنة بياناته  Maxضية نكتب الصيغة الريا -3                                            

 قيمة عددية فيه . الرقمية لأيجاد أكبر                                                 
 من لوحة المفاتيح لللحصول على ناتج   Enterننقر على مفتاح الأدخال  -4                                            

 المقارنة .                                                
                       

 أكتب صيغة         (B1:B3),(R4:R6)رقمية في المديات  خل بياناتدأتمرين عملي :               
 ن واضعا" الناتج قيمة رقمية لهذان المديا رياضية صحيحة لأيجاد أكبر                                             

 : على التوالي G6و  A5في الخلايا                                              
                        
 ثم ننقر على  Max(B1:B3)=نكتب الصيغة الرياضية  A5الحل : في الخلية                       

 . Enterمفتاح                                            
 ثم ننقر على  Max(R4:R6)=نكتب الصيغة الرياضية  G6في الخلية                                       

 .   Enterمفتاح                                            
                    -------------------------------------------------------------------------------------- 

 
 وكما يلي : Fx الطريقة الثانية : من معالج الدوال                        
 نضع مؤشر الماوس في الخلية المراد كتابة الصيغة الرياضية . -1نتبع الخطوات التالية  :                         

 بيسار الماوس على آيكونة معالج الدوال الموجودة على شريط   ننقر-2                                                      
 الصيغة.                                                          

  Maxأنقر فوق  (Insert Function)من مربع الحوار الأول  -3                                            
 . OKمن قائمة أختيار الدوال ثم ننقر على مربع                                                   
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 . OKانات الرقمية المراد جمعها باستخدام معالج الدوال ثم ننقرعلى مربع ينكتب المدى للب -4                         

                                                   

                               
 
 

 ثم أستخدم معالج الدوال  (B1:B3),رقمية في المدى  خل بياناتدأتمرين عملي :                                  
                              . B4المدى واضعا" الناتج في الخلية  أكبر قيمة عددية في هذا  لأيجاد                                                  

                        
 ثم  B4ننقر على الخلية  الحل :                         

                                                        Fx→all→max→ok→(B1:B3)→ok  
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                    هناك طريقتان / الطريقة الأولى  :( Count ) ساب عدد الخلايا الرقميةح                      

 نضع مؤشر الماوس في الخلية المراد كتابة الصيغة الرياضية . -1نتبع الخطوات التالية  :                 
 كتابة صيغة رياضية . دلالة على نكتب أشارة (=) -2                                            

 ة بأسم المدى المراد حساب متبوع Countنكتب الصيغة الرياضية -3                                            
 عدد خلاياه .                                                 

 لوحة المفاتيح للحصول على عدد  من  Enter ننقر على مفتاح الأدخال -4                                            
 . الخلايا                                                 

                                        ------------------------------------------------------------------- 
 

 أكتب صيغة         (C1:C5),(D1:F4)رقمية في المديات  بيانات خلدأتمرين عملي :                               
 رياضية  رقمية لحساب عدد الخلايا الرقمية لهذان المديان واضعا" الناتج                                              
 على التوالى : G6و  A5في الخلايا                                              

                        
 ثم ننقر على  Count(C1:C5)=نكتب الصيغة الرياضية  A5الحل : في الخلية                       

 . Enterمفتاح                                            
 نقر على ثم ن Count(D1:F4)=نكتب الصيغة الرياضية  G6في الخلية                                       

 .   Enterمفتاح                                            
                                       ---------------------------------------------------------------------- 

 وكما يلي : Fx الطريقة الثانية : من معالج الدوال                       
                        

 نضع مؤشر الماوس في الخلية المراد كتابة الصيغة الرياضية . -1نتبع الخطوات التالية  :                         
                        

 ى شريط  ننقر بيسار الماوس على آيكونة معالج الدوال الموجودة عل-2                                                    
 الصيغة.                                                          

                       
  Countأنقر فوق  (Insert Function)من مربع الحوار الأول  -3                                             

 . OKمة أختيار الدوال ثم ننقر على مربع  من قائ                                                 
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 . OKانات الرقمية المراد جمعها باستخدام معالج الدوال ثم ننقرعلى مربع ينكتب المدى للب -4                       
                                                   

                               
 

                ------------------------------------------------------------------------------- 
 ثم أستخدم معالج الدوال  (A1:H10),رقمية في المدى  خل بياناتدأتمرين عملي :                                 

 .                              J1لحساب عدد الخلايا  في هذا المدى واضعا" الناتج في الخلية                                                   
                        

 ثم  J1الحل :     ننقر على الخلية                          
                                                        Fx→all→Count→ok→(A1:H10)→ok  
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                    هناك طريقتان / الطريقة الأولى  :( Average ) حساب الوسط أو المعدل الحسابي                  

 نضع مؤشر الماوس في الخلية المراد كتابة الصيغة الرياضية . -1نتبع الخطوات التالية  :                 
 دلالة على كتابة صيغة رياضية . نكتب أشارة (=) -2                                            

 متبوعة بأسم المدى المراد حساب Averageنكتب الصيغة الرياضية -3                                            
 المعدل الحسابي لها .                                                  

 المفاتيح لللحصول على ناتج  من لوحة  Enterننقر على مفتاح الأدخال  -4                                            
 . الصيغة                                                

                                          ------------------------------------------------------------------ 
                              
 أكتب صيغة         (C1:C5),(D1:F4)رقمية في المديات  خل بياناتدأرين عملي : تم                              

 رياضية  رقمية لحساب الوسط الحسابي لهذان المديان واضعا" الناتج  في                                              
 والى :على الت G6و  A5الخلايا                                                

                        
 ثم ننقر على  Average(C1:C5)=نكتب الصيغة الرياضية  A5الحل : في الخلية                       

 . Enterمفتاح                                            
 ثم ننقر   Average(D1:F4)=نكتب الصيغة الرياضية  G6في الخلية                                       

 .   Enterعلى مفتاح                                             
                           ------------------------------------------------------------------------------ 

 لي :وكما ي Fx الطريقة الثانية : من معالج الدوال                     
                        
 نضع مؤشر الماوس في الخلية المراد كتابة الصيغة الرياضية . -1نتبع الخطوات التالية  :                         
                        

 الموجودة على شريط   ننقر بيسار الماوس على آيكونة معالج الدوال-2                                                    
 الصيغة.                                                          

                       
 أنقر فوق  (Insert Function)من مربع الحوار الأول  -3                                                   

      Average                                          من قائمة أختيار الدوال ثم ننقر على مربعOK . 
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 OKانات الرقمية المراد جمعها باستخدام معالج الدوال ثم ننقرعلى مربع ينكتب المدى للب -4                          
. 

                                                   

                               
                        

                          
 ثم أستخدم معالج الدوال  (A1:H10),رقمية في المدى  خل بياناتدأتمرين عملي :                                    

 لحساب  المعدل أو الوسط الحسابي لهذا المدى واضعا" الناتج في الخلية                                                   
                                                   J1                              . 

                        
 ثم  J1:     ننقر على الخلية  الحل                                           

 
                                                        Fx→all→Average→ok→(A1:H10)→ok  

                      



 30 

 
 

 ) : Wrong Formulaالصيغ التي تنتج قيم خطأ (            
 

 ولا  م الخطأ مبدوءة بعلامة (#)تظهر قي Excelفة لما يتوقعه معينة مخالقيم  خالعند أد       
 يستطيع حساب الصيغة بالصورة الصحيحة , وأمثلتها :       

  Name#قادر على التعرف عليها                رأسماء غي            
       Null#تعيين تقاطع للمصفوقتين غير صالح                      
          NIA#                صيغة غير متاحة                          
                 #####العمود ضيق                                    

     Value#           لا يستطيع تحويل النص الى أرقام              
                     

                     ------------------------------------------------------------------------------- 
 
  

 .  Excel سندرس هذة القائمة وما تحتويه من أوامر تعمل في برنامج  ( تحرير ): Editقائمـــة                   
                  

 (قص أو نقل أو تحريك ) : لنقل  بيانات  الخلايا من مكان الى آخر على نفس وقة  Cutالأمـر 1- 
 ( سواء أكانت بيانات خلية واحدة أو بيانات مدى معين أو بيانات عمود او صف ) أو نقل  العمل     
 البيانات من مكان ما على ورقة العمل الحالية ( التي تدخل بياناتك عليها ) الى مكان ما على ورقة      
 ة  :)التاليأحد الطرق الثلاثعمل أخرى  تحدد لك حسب مطلوب السؤال عندها نتبع (      
        

 عندها نتبع الخطوات العملية التالية : :  Editمــن قائمـة  : أولا"  أمــــا  
 نحدد أو نظلل بيانات الخلايا المراد قصها أو نقلها ( سواء أكانت خلية واحدة أو مدى معين أو -1   

 وب نقله في السؤال .أكمله أو صف بأكمله أو ورقة العمل بأكملها ) حسب ما مطلعمود ب              
 . Menu Barائم الرئيسي ومن شريط الق Editننقر بيسار الماوس على قائمة  – 2         
 ستلاحظ (بيسار الماوس Cutالأمر  (2)التي ستفتح بعد تنفيذ خطوة   Editنختار من قائمة  -3                    

 تحت أمر  (ستأطر بأطار منقط دلالة على أنها (1)ددت في الخطوة أن البيانات التي ظللت أو ح                        
 . )القص أو النقل                        

 ننقر بيسار الماوس على الخلية التي تمثل بداية مكان اللصق (الذي سيتم لصق البيانات المنقولة -4                    
 ). االيه                         

 مرة أخرى . Editننقر على قائمة  – 5                    
 أن البيانات بيسار الماوس , عندها ستلاحظ  (لصق) Pastالأمر  Editنختار من قائمة  -6                    

 لذيستنقل الى المكان الجديد الذي لصقت عليه مع عدم بقاء نسختها الأصلية في مكانها  الأول ا                         
 كانت فيه قبل القص أو النقل .                         

    
                    ------------------------------------------------------------------------------------- 
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 زل أمامك في أدناه :والمن حفوظ بأسم ( درجات طلابية ) مأفتح ملفك المخزون أو التمرين عملي :                  

                
                                             

 
 

 خال درجات لها دأعمل أولا" على أدخال تسلسل طالب جديد وليكن أسمه ( مريم هادي ) دون أ                    
                

 
 
 
 

 ثم  )مريم() وأجعلها للطالبة  ( سهىقل درجات الطالبةنأ  Editوالمطلوب وباستخدام قائمة                 
 أو شرط الأدوات  : Fileأحفظ هذه التعديلات باستخدام أما قائمة                     

بأسم الطالبة (مريم هادي ) نعمل على تطبيق الخطوة العملية التالية    (4)خال تسلسل رقم دالحل : بعد أ              
: 

                       
                       Edit ←Cut ←L C on C5 ← Edit ←past← (C3:E3)نظلل                       

                                                    LC      LC                                  LC        LC 
 ة العملية أعلاه على ورقة العمل ضمن هذا الملف وكما في أدناه ثمعندها سنلاحظ عمليا" ناتج الخطو             
 من شريط   LC on Icon أو     File →Saveننفذ الخطوة العملية المطلوبة في السؤال              
 الأدوات .             

 
 
 

 في الشكل أدناه  :)( لاحــظ ناتج تنفيذ أيعاز القص أو النقل كما                                 
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                      -------------------------------------------------------------------------------------- 
 

 ):(Minu Barأو ثـانيـا" :  نقل أو قص البيانات باستخدام شريط الأدوات                     
 طريقة العمل :                                 

  
 نحدد أو نظلل بيانات الخلايا المراد قصها أو نقلها ( سواء أكانت خلية واحدة أو مدى معين أو -1      

 عمود بأكمله أو صف بأكمله أو ورقة العمل بأكملها ) حسب ما مطلوب نقله في السؤال .                      
 (ستلاحظ أن البيانات التي ظللت أو  ,من شريط الأدوات   بيسار الماوس على الآيكونة  ننقر -2               

 ستأطر بأطار منقط دلالة على أنها تحت أمرالقص أو النقل) . (1)حددت في الخطوة                      
 ي سيتم لصق البيانات المنقولةننقر بيسار الماوس على الخلية التي تمثل بداية مكان اللصق (الذ -3               

 اليها ).                         
                 

 عندها ستلاحظ أن البيانات  من شريط الأدوات , ننقر بيسار الماوس على الآيكونة  -4               
 ا الأصلية في مكانها  الأول الذيستنقل الى المكان الجديد الذي لصقت عليه مع عدم بقاء نسخته                         
 كانت فيه قبل القص أو النقل .                         

                          -------------------------------------------------------------------------- 
 ) الى الطالبة  ة ( سهىبيانات الطالبنفس التمرين العملي السابق أعمل على قص  تمرين عملي :                  
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 ( مريم ) ولكن بأستخدام شريط الأدوات :                                     
 الحل :                   

 Lc on  ← L C on C5←   Lc on← (C3:E3)نظلل                              
 

 ذه الخطوة العملية كما في الناتج الذي حصلنا عليه في التمرين السابق:عندها سنلاحظ ناتج تنفيذ ه                    
 
 
 

 أو ثـالثـا" :  نقل أو قص البيانات باستخدام فعالية يمين الماوس:                    
 طريقة العمل :                                 

 
 نقلها ( سواء أكانت خلية واحدة أو مدى معين أو نحدد أو نظلل بيانات الخلايا المراد قصها أو -1          

 عمود بأكمله أو صف بأكمله أو ورقة العمل بأكملها ) حسب ما مطلوب نقله في السؤال .                      
 ستفتح قائمة أوامر . (1)ننقر بيمين الماوس على أية خلية محددة أو مظللة في خطوة  -2                   

 (ستلاحظ أن البيانات التي ظللت أو حددت في الخطوة  ) من قائمة الأوامر ,(Cutنختار الأمر  -3                  
 ستأطر بأطار منقط دلالة على أنها تحت أمرالقص أو النقل) . (1)                       

 ق (الذي سيتم لصق البيانات المنقولةننقر بيسار الماوس على الخلية التي تمثل بداية مكان اللص -4                  
 اليها ).                         

                 
 ستفتح قائمة أوامر . (4)ننقر بيمين الماوس على الخلية التي حددت في خطوة  -5                   
 المكان الجديد الذي لصقت عليه عندها ستلاحظ أن البيانات ستنقل الى  , Pastنختار الأمر  – 6                   

 مع عدم بقاء نسختها الأصلية في مكانها  الأول الذي كانت فيه قبل القص أو النقل .                          
 

                         --------------------------------------------------------------------------- 
                 

 ) الى الطالبة  ة ( سهىنفس التمرين العملي السابق أعمل على قص بيانات الطالب تمرين عملي :                
 ( مريم ) ولكن بأستخدام فعلية الماوس                                     

 الحل :                          
  RC on any cells on(C2:E2) ←Cut←Rc On C5 ← (C2:E2)نظلل              

                      ←past  , 
 

                  
 عندها سنلاحظ ناتج تنفيذ هذه الخطوة العملية كما في الناتج الذي حصلنا عليه في التمرين السابق:                 

             --------------------------------------------------------------------------------------------- 
 

 لنسخ  بيانات  الخلايا من مكان الى آخر على نفس وقة  (نسخ): Copyالأمر  -2           
  ت عمود او صف ) أو نسخالعمل ( سواء أكانت بيانات خلية واحدة أو بيانات مدى معين أو بيانا     
 لتي تدخل بياناتك عليها ) الى مكان ما على ورقة البيانات من مكان ما على ورقة العمل الحالية ( ا     
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 )التالية  :أحد الطرق الثلاثعمل أخرى  تحدد لك حسب مطلوب السؤال عندها نتبع (      
        

 عندها نتبع الخطوات العملية التالية : :  Edit: مــن قائمـة  أولا"  أمــــا  
 
 
 
 
 

 سخها ( سواء أكانت خلية واحدة أو مدى معين أونحدد أو نظلل بيانات الخلايا المراد ن -1
 عمود بأكمله أو صف بأكمله أو ورقة العمل بأكملها ) حسب ما مطلوب نسخه في السؤال .              

 . Menu Barمن شريط القوائم الرئيسي  Editننقر بيسار الماوس على قائمة  – 2         
        Copyالأمر  (2)التي ستفتح بعد تنفيذ خطوة   Editنختار من قائمة  -3                    

 ستأطر بأطار منقط  (1)بيسارالماوس(ستلاحظ أن البيانات التي ظللت أو حددت في الخطوة                          
 دلالة على أنها تحت أمر  النسخ) .                         

 وس على الخلية التي تمثل بداية مكان اللصق (الذي سيتم لصق البيانات  ننقر بيسار الما -4                    
 المنسوخة اليها ).                         

 مرة أخرى . Editننقر على قائمة  – 5                    
 البيانات (لصق) بيسار الماوس , عندها ستلاحظ أن  Pastالأمر  Editنختار من قائمة  -6                    

 بقاء نسختها الأصلية في مكانها  الأول الذي كان الجديد الذي لصقت عليه مع الى الم ستنسخ                         
 . اء عملية النسخركانت فيه قبل  اج                         
                   -------------------------------------------------------------------------------------- 

 والمنزل      حفوظ بأسم ( درجات طلابية ) مأفتح ملفك المخزون أو التمرين عملي :                      
 أمامك في أدناه :                          
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 خال درجات لها دأعمل أولا" على أدخال تسلسل طالب جديد وليكن أسمه ( مريم هادي ) دون أ                  

 لب( أحمد ) وأجعلها للطالبة مريم ثم ادرجات الط نسخأ  Editوالمطلوب وباستخدام قائمة                     
 أو شرط الأدوات  : Fileائمة أحفظ هذه التعديلات باستخدام أما ق                    

بأسم الطالبة (مريم هادي ) نعمل على تطبيق الخطوة العملية التالية    (4)خال تسلسل رقم دالحل : بعد أ              
: 

                       
                       Edit ←Copy ←L C on C5 ← Edit ←past← (C2:E2)نظلل                       

                                                    LC      LC                                  LC        LC 
 عندها سنلاحظ عمليا" ناتج الخطوة العملية أعلاه على ورقة العمل ضمن هذا الملف وكما في أدناه ثم             
 من شريط   LC on Icon أو     File →Saveفي السؤال  ننفذ الخطوة العملية المطلوبة             
 الأدوات .             

 
 كما في الشكل أدناه  :) ظ ناتج تنفيذ أيعاز النسخ( لاحــ                       

            
 

 
 

 ات الطالب احمد( لاحظ أن درجات الطالب أحمد قد نسخت كدرجات للطالبة مريم مع بقاء درج                    
 في مكانها الأصلي )                       

                 --------------------------------------------------------------------------------------- 
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 مــلاحظـــــة:                             
 أن أيعازالقص ينقل البيانات  Copyعن أيعاز النسخ  Cut ن فرق أيعاز القصأ 1-                            

 مع عدم بقاء نسخة لتلك البيانات في مكانها المقصوصة أو المنقولة الى المكان الجديد                                
 الذي نسخت اليه  يانات في مكانها الجديدعمل نسخة للبالأصلي بينما أمر النسخ يعمل على                                
 انات في مكانها الأصلي .يمع ترك أو بفاء النسخة الأصلية للب                               

 من لصق البيانات الى أن أمر القص يعمل لمرة واحدة فقط أما أمر النسخ الواحد يمكننا  -2                           
 عدد غير منتهي  من المرات ألا أذا أنهينا عمل أمر النسخ وكما سيأتي في الملاحظة                                 

 . التالية                                 
 (الهروب أو الخروج)   (Esc)يتم أنهاء عمل أمر النسخ وذلك بالنقر على مفتاح -3                            

 الموجود في أقصى أعلى  يسار لوحة المفاتيح .                                
                    ------------------------------------------------------------------------------------------ 

             
 ):(Minu Barالبيانات باستخدام شريط الأدوات   ثـانيـا" :  نسخ أو                     

 طريقة العمل :                                 
 نحدد أو نظلل بيانات الخلايا المراد نسخها ( سواء أكانت خلية واحدة أو مدى معين أو -1                    

 ال.عمود بأكمله أو صف بأكمله أو ورقة العمل بأكملها ) حسب ما مطلوب نسخه في السؤ                      
                   

 (ستلاحظ أن البيانات التي     (نسخ) من شريط الأدوات , ننقر بيسار الماوس على الآيكونة   -2                      
 ستأطر بأطار منقط دلالة على أنها تحت أمرالنسخ) . (1)ظللت أو حددت في الخطوة                            

 ننقر بيسار الماوس على الخلية التي تمثل بداية مكان اللصق (الذي سيتم لصق البيانات  -3                    
 المنسوخة اليها ).                        

 عندها ستلاحظ أن البيانات  من شريط الأدوات , ننقر بيسار الماوس على الآيكونة  -4                
 ى المكان الجديد الذي لصقت عليه مع  بقاء نسختها الأصلية في مكانها  الأول الذيستنسخ ال                         
 كانت فيه قبل النسخ .                         

                          --------------------------------------------------------------------------                                  
 نفس التمرين العملي السابق أعمل على نسخ بيانات الطالب ( أحمد ) الى الطالبة  تمرين عملي :                        

 ( مريم ) ولكن بأستخدام شريط الأدوات :                                     
 الحل :                   

Lc on← (C2:E2)نظلل                                 ← L C on C5←   Lc on 
 

 عندها سنلاحظ ناتج تنفيذ هذه الخطوة العملية كما في الناتج الذي حصلنا عليه في التمرين السابق:                    
 
 

                          ----------------------------------------------------------------------------- 
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 البيانات باستخدام فعالية يمين الماوس: أو ثـالثـا" :  نسخ                                
 طريقة العمل :                                 

 
 نسخها ( سواء أكانت خلية واحدة أو مدى معين أو نظلل بيانات الخلايا المراد  نحدد أو -1          

 أكمله أو صف بأكمله أو ورقة العمل بأكملها ) حسب ما مطلوب نسخه في السؤال .عمود ب                      
 ستفتح قائمة أوامر . (1)ننقر بيمين الماوس على أية خلية محددة أو مظللة في خطوة  -2                   
 ظللت أو حددت في  (ستلاحظ أن البيانات التي ) من قائمة الأوامر ,(Copyنختار الأمر  -3                  

 ستأطر بأطار منقط دلالة على أنها تحت أمرالنسخ) . (1)الخطوة                       
 ننقر بيسار الماوس على الخلية التي تمثل بداية مكان اللصق (الذي سيتم لصق البيانات المنسوخة -4                  

 اليها ).                         
                 

 ستفتح قائمة أوامر . (4)ننقر بيمين الماوس على الخلية التي حددت في خطوة  -5                   
 عندها ستلاحظ أن البيانات ستنسخ الى المكان الجديد الذي لصقت عليه  , Pastنختار الأمر  – 6                   

 مكانها  الأول  . مع  بقاء نسختها الأصلية في                          
                    ------------------------------------------------------------------------------------ 

 
 نفس التمرين العملي السابق أعمل على نسخ بيانات الطالب ( أحمد ) الى الطالبة  تمرين عملي :                     

 ( مريم ) ولكن بأستخدام فعلية الماوس                                     
 الحل :                          

  RC on any cells on(C2:E2) ←Copy←Rc On C5 ← (C2:E2)نظلل              
                      ←past  , 

 
                  
 لعملية كما في الناتج الذي حصلنا عليه في التمرين السابق(أيعندها سنلاحظ ناتج تنفيذ هذه الخطوة ا                 
 ستنسخ درجات الطالب أحمد للطالبة مريم مع بقاء درجات الطالب أحمد في مكانها )                  

 
                     ---------------------------------------------------------------------------------    
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 والمدخلة فيه البيانات التالية :  Excelلديك الملف التالي في برنامج تمرين عملي :                     
                     

          

 
 

 والمطلوب أعمل على تنفيذ ما يأتي :                 
 ية الماوس .فعالأنسخ بيانات المريض(  كامل ) للمريضة (هبة) مستخدما" 1-
 ) وبأسم ( فاطمة محمد ) . 4أدخل بيانات كاملة لمريض يحمل التسلسل ( 2-
 أنقل بيانات المريض ( وائل ) الى المريضة ( فاطمة ) مستخدما" شريط الأدوات . -3

 .Editأنسخ بيانات المريضة (  فاطمة ) الى المريض ( وائل ) مستخدما" قائمة  -4                  
 . Fileأحفظ كل البيانات السابقة بأسم ملف يحمل أسم ( بيانات مرضى ) مستخدما" قائمة  -5                  

 ريط الأدوات .مستخدما" ش 2) ورقة (Sheet2الى  1ورقة  (sheet1)أنسخ بيانات  -6                  
 الى الصف العاشر  (sheet1) في الورقة الأولى (Row1)أنقل بيانات الصف الأول  -7                  

                         (Row10)  مستخدما" قائمة .Edit . 
 مستخدما" فعالية يمين الماوس . Sheet3الى  Sheet2أنقل بيانات  -8                  
 مستخدما" شريط الأدوات .  Fالى العمود  Cأنسخ بيانات العمود  -9                  

 .Editقائمة مستخدما"  H1الى الخلية  A4قص بيانات الخلية  -10                  
 أحفظ التعديلات السابقة على نفس الملف مستخدما" شريط الأدوات . -11                   
 . Fileأغلق الملف (بيانات مرضى ) من قائمة  -12                   
 . Fileمن قائمة  Excelأغلق برنامج  -13                   

 
             ---------------------------------------------------------------------------------------------- 
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  أن هذا الأمر من أوامرنقل أو نسخ ورقة العمل :  (Move or copy sheet)الأمر  -3               
 عمل هذا الأمر على تنفيذ أمرين يخص أوراق العمل الموجودة على  شريط حيث ي Editقائمة                      
 الأوراق من ناحية أما نسخها أو نقلها على شريط الأوراق  وطريقة العمل تتم بأحد الطريقتين                    
 ويتم ذلك كما يلي : Editمن قئمة   أمــــــاالتاليتين :                     

 ي ننقر بيسار الماوس على أسم ورقة العمل المراد نقلها أو نسخها على شريط الأوراق نحدد أ1- 
 من شريط القوائم , ستفتح قائمة الأوامر الخاصة بهذه القائمة . Editننقر على قائمة  -2

 ي ) بيسار الماوس , سيفتح مربع حوار كما ف(Move or copy sheetنختار الأمر  -3                      
 أدناه :                           

                                     
 ننقر بيسار الماوس (قبل أي ورقة عمل يراد عمل نسخة أو نقل ورقة العمل المحددة في خطوة  -4                    

                                        (1)                  
 

 في حالة يراد نقل الورقة وألا ننقر بيسار الماوس ( أي نفعل ) المربع (OK)على مربع  ننقر -5                   
   في حالة  (OK)ثم ننقر على مربع  )أنشاء نسخة(  (Create sheet)المجاور لعبارة                         
 الأوراق . رقة العمل على شريط لو هذا الأختيار سيتم عمل نسخة ثانية                        

   

                               
             

                 



 40 

 
 

  يتم من خلاله نقل أو نسخ ورقة العمل ( Move or copy sheet)أن أمر مــــلاحظـة :                   
 ريط الأوراق بغض النظر عن كون ورقة العمل نقل أو نسخ أوراق العمل على ش                                  
 تحتوي على بيانات أو خالية من البيانات .                                  

                       ----------------------------------------------------------------------------- 
 

 مل باستخدام فعالية الماوس ) : طريقة العمل كالتالي :(نقل أو نسخ ورقة العأو                 
                 

 نحدد أي ننقر بيسار الماوس على أسم ورقة العمل المراد نقلها أو نسخها على شريط الأوراق 1-
 . (1)على الورقة التي حددت في خطوة  ننقر بيمين الماوس -2 

 الأمر نقل أو نسخ ورقة  2)(  التي ستفتح بعد تنفيذ خطوةنختار من قائمة الأوامر  -3                 
                       (Move or copy sheet )  : كما مبين في أدناه 
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 عندها سيفتح مربع الحوار التالي لتفعيل أما أمر النسخ أو أمر النقل للورقة المحددة :                     
 أمــــا : نقل                        

                                  
 
 أو أمر تفعيل أنشاء نسخة : 
 

                       
 
  

                                   ----------------------------------------------------------------- 
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 الى نهاية شريط الأوراق لبرنامج  (Sheet1) 1أعمل على نسخ ورقة  تمرين عملي :                      

                                          Excel   3ثم أنقل ورقة (sheet3)  1الى بداية الشريط أي قبل ورقة 
 للمطلوب رالأول وفعالية الماوس   Editة مستخدما" قائم على شريط الأوراق                                         

 للمطلوب الثاني :                                         
 الى نهاية شريط الأوراق : 1لنسخ ورقة  الحــــل :                     

                           Ok→ Sheet1→Edit→Move or copy sheet→Move to End→Creat acopy 
       LC         LC             L C                           LC                  LC                LC                     

 

 : 1الى ما قبل ورقة  3لنقل أو قص ورقة                                  
                                             Ok→ Sheet3→mous→Move or copy sheet→sheet1→ 

                                                          LC         RC             L C                           LC           LC 
 --------------------------------------------------------------------------------- 
 

 والتي مر  يستخدم هذا الأمر للصق البيانات المنسوخة أو المنقولة (لصق )  Pastالأمر  -4                       
 .  Edit في قائمة شرحها مسبقا"                            
                          -------------------------------------------------------------------------------- 

 حيث يتم تنظيف  Editعلى قائمة يوجد هذا الأمر  (تنظيف أو مسح ) :Clearالأمر  -5                       
 أو مسح البيانات مع بقاء الخلايا فارغة في أماكنها  والطريقة العملية تتم كما يأتي :                             

 المراد تنظيف أو مسح بياناتها ( سواء أكانت خلية أو مدى معين أو  نحدد أو نظلل الخلايا -1                        
 صف أو عمود أو ورقة العمل بأكملها ) .                             

 من شريط القوائم بيسار الماوس , ستفتح قائمة الأوامر . Editنفتح قائمة  -2                         
 , ستلاحظ أن بيانات  allثم نختار الأمر  ( مسح ) بيسار الماوسClearختار الأمر ن-3                          

 قد مسحت مع بقاء أماكن الخلايا فارغة في أماكنها . (1)خطوة المنطقة التي حددت في                              
                     

 لذلك كما يأتي :لمسح وهي فعالية يمين الماوس والطريقة العملية لتنفيذ أمر ا هناك طريقة ثاتية                      
                

 نحدد أو نظلل الخلايا المراد تنظيف أو مسح بياناتها ( سواء أكانت خلية أو مدى معين أو  -1                    
 صف أو عمود أو ورقة العمل بأكملها ) .                             

 ,ستفتج قائمة  (1)ننقر بيمين الماوس على أي جزء من المنطقة المحددة أو المظللة في خطوة  -2                     
 أوامر .                          

 , ستلاحظ أن بيانات (مسح المحتويات Clear Contentsنختار من القائمة الأمر  -3                      
 قد مسحت مع بقاء أماكن الخلايا فارغة في أماكنها . (1)المنطقة التي حددت في خطوة                           

 
                      ------------------------------------------------------------------------------------- 
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 صية في الخلايا والمديات والصفوف والأعمدة التالية ثم أعمل أدخل بيانات رقمية أو نعملي : ن ـتمري               
 وأخرى  Editت على التوالي  مستخدما" مرة قائمة تلك البيانا مسح أو تنظيفعلى                                   

 فعالية يمين الماوس :                                   
  A1,D3,H7,J10لايــــــــــــا :الخ                               
 (w2:W21),(F4:F7),(B1:B3):  المديــــــــــات                               
  Row3 , Row9الصفــــــــوف :                                
 Column C , Column Kالأعمـــــــــــدة  :                               

 
                 ----------------------------------------------------------------------------------------- 

 (حذف ) : أن أمر الحذف هذا يمكننا من حذف صفوف وأعمدة بأكملها  Deleteالأمـر  -6                  
 لتها من ورقة العمل وأنتقال الخلايا المحيطة لتعبئة الفراغ :فيتم أزا                                                           

 : (Delete)وهناك طريقتان للوصول الى تنفيذ أمر الحذف                        
 ذ ذلك كما يأتي :يوالطريقة العملية لتنف:  Editالأولــــــــــــى : من قائمـة                         

  أولا" : كيف يتم حذف البيانات المدخلة في الصفوف  :سنتعرف                         
 نحدد أو نظلل الصف المراد حذف بياناته (وذلك بالنقر على رقم الصف ) . -1                       
 , ستلاحظ أن بيانات ذلك الصف ستحذف  Editمن قائمة  Deleteننقر على الأمر  -2                       

 وتعبأ بيانات الصف الذي يليه الى ذلك الصف الذي حذفت بياناته .                           
                           

     حذف البيانات المدخلة في الأعمدة :: ثانيـــا"                              
 ه (وذلك بالنقر على أسم العمود ) .نحدد أو نظلل العمود المراد حذف بيانات -1                           

 , ستلاحظ أن بيانات ذلك العمود ستحذف  Editمن قائمة  Deleteننقر على الأمر  -2                           
 الذي حذفت بياناته . بيانات العمود الذي يليه الى ذلك العمودوتعبأ                                 

                     ------------------------------------------------------------------------------------ 
 :أدخل بيانات رقمية في الأعمدة والصفوف التالية تمرين عملي :                  

                                      (  4 , 3 , 2 , 1)والصفوف  ( A ,B , C , D)الأعمدة                                
  (2,3)ثم أحذف بيانات الصفوف  ( B , C)ثم أعمل على حذف بيانات الأعمدة                               
 . Editمستخدما" قائمة                                

                                ------------------------------------------------------------------------- 
 حذف البيانات المدخلة الى الخلايــا : رابعــا" :                           
 قر بيسار الماوس على تلك الخلية  نحدد أو نظلل الخلية المراد حذف بياناتها وذلك بالن -1                         
 التالي : Deleteحوارسيفتح مربع  ,  Editمن قائمة  Deleteننقر على الأمر  -2                         
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 حيث يحتوي مربع الحوار هذا على أربعة خيارات تختار من خلالها طريقة الحذف المطلوب تنفيذها                   

 ( أزاحة الخلايا لليسار) . Shift cells left -1وهي :                    
                            2-Shift cells up . ( أزاحة الخلايا للأعلى ) 

                            3- Entire Row  . ( الصف بأكمله ) , أي أزاحة الصف الذي تقع عليه تلك الخلية 
                            4-Entire Column . ( العمود بأكمله ) أي حذف العمود الذي تقع عليه تللك الخلية 

 بيسار الماوس .  OKأخيرا" على مربع وفي حالة أختيار أي من الخيارات أعلاه ننقر                                
                        --------------------------------------------------------------------------------------- 

  
 وهي : Deleteالطريقــة الثانــيـة : لتنفيذ أمـر الحذف                            
 وطرقة العمل كالتالي : طريقــة فعاليـة يميـن المـاوس :                           
 . نحدد أو نظلل بيانات الخلية المراد حذفها  -1                          
 , عندها ستفتح قائمة أوامر أختر  (1)ننقر بيمين الماوس على الخلية المحددة في خطوة  -2                          

 . Deleteمنها الأمر (حذف)                                
 ستلاحظ مايأتي : أولا": أذا حذف صف بأكمله ستزاح وتنتقل بيانات الصف الذي يليه بدل                      

 بيانات الصف التي حذفت  .                                                     
 ثـانيـــــا: أذاحذفت عمود بأكمله ستنتقل بيانات العمود الذي يليه بدل بيانات   أو                                    

 العمود التي حذفت .                                                      
 عندها  (Delete)أو           ثـالثـــــا": أذا حذفت خلية سيظهر لك مربع حوار حذف                           

 ستختار أحد الخيارات الأربعة حسب ما مطلوب حذفه .                                                      
                        ----------------------------------------------------------------------------------- 

 
                             

                   
                   



 45 

      
 :أدخل بيانات رقمية في الأعمدة والصفوف التالية تمرين عملي :                                     

                                      (  4 , 3 , 2 , 1)والصفوف  ( A ,B , C , D)الأعمدة                                
  (2,3)ثم أحذف بيانات الصفوف  ( B , C)ثم أعمل على حذف بيانات الأعمدة                               

 (A3,A4,A5مستخدما" فعالية يمين الماوس ثم أدخل بيانات رقمية في الخلايا                                
                                                               (B3,B4,B5,C3,C4,C5 
  B4ثم أحذف الصف الواقعة عله الخلية                                
 B4ثم أحذف العمود الواقعة عليه الخلية                                
                             ------------------------------------------------------------------------------- 

 : ( Delete Sheet)حذف ورقة العمل الأمر  -7               
               شريط الأوراقلحذف وألغاء ورقة العمل سواء أكانت تحتوي على بيانات أو خالية من البيانات من                    
 ن التاليتين :نتبع أحد الطريقتي Exeleالموجود أسفل ورقة العمل في برنامج                    
 نتبع الخطوات العملية التالية ::  Editأولا" : من قائمة                   

 . ( من شريط الأوراق ) على ورقة العمل المراد حذفها نحدد أو ننقر بيسار الماوس -1                    
 ستظهر لك رسالة تنبيهية مفادها, عندها  Editمن قائمة  Delete Sheetنختار الأمر  -2                    

 أنه ستم حذف ورقة العمل وما تحتويه من بيانات فأذا رغبت بالحذف أنقر على مربع                           
                         Delete  وألا أنقر على مربعCancel : وشكل الرسالة كالتالي. 

                                                                                                                                             

 
 
 

 في حالة كون الورقة التي تريد حذفها من على شريط الأوراق خالية من البيانات فأن عملية  1-ملاحظة :          
 أن تظهر لك هذه الرسالة التنبيهية . حذف الورقة  سيتم بدون                           
 واحدة بعد الأخرى  الأوراق واحدة على شريط الأوراق بعد حذف عمل في حالة بقاء ورقة - 2

 رفضا" من خلال رسالة مفادها أنه لايمكن  Excelهذه الحالة يعطيك برنامج  ففي       
 عمل واحدة أفتراضية على  حذف ورقة العمل هذه وذلك لأنه على الأقل يجب بقاء ورقة       
 شريط الأوراق والرسالة هي كالتالي :       
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  هي أحدى القوائم الموجودة في شريط القوائم الرئيسي لبرنامج:  (Insert)قائمـــــــة أدراج                  

                                                     Excel :: وسنأخذ من هذه القائمة الأوامر التالية 
 حيث يتم أدراج صف جديد خالي من البيانات قبل الصف الذي (صفوف ):  Rowsالأمر 1-

 وكما يلي : Excelحدد أو ظلل مسبقا" في ورقة عمل                                         
                     
 حدد أو نظلل الصف المراد أدراج صف جديد (خالي من البيانات ) قبله  .ن -1                   
 , عندها ستلاحظ أدراج صف جديد قبل الصف  Insertمن قائمة  Rowsنختار الأمر  -2                   

 . (1)الذي ظلل أو حدد في خطوة                        
                     ----------------------------------------------------------------------------------- 

  ( أعمدة ) : حيث يتم أدراج عمود  جديد خالي من البيانات قبل العمود Columnsالأمر  -2                  
 وكما يلي  : Excelالذي حدد أو ظلل مسبقا" في ورقة عمل                        
 

 جديد (خالي من البيانات ) قبله  . نحدد أو نظلل العمود المراد أدراج عمود -1                              
             جديد  , عندها ستلاحظ أدراج عمود Insertمن قائمة  columnsنختار الأمر  -2                             

 . (1)حدد في خطوة  الذي ظلل أو العمودقبل                                   
                  ---------------------------------------------------------------------------------------- 

               
 :العمل كما يأتي وطريقة) :فعالية يمين الماوسهناك طريقة ثانية لأدراج صف أو عمود جديد وهي(                

  
 نظلل أو نحدد الصف أو العمود الذي نريد أدراج صف أو عمود جديد قبله . -1                  

 ننقر بيمين الماوس على أية خلية ضمن خلايا العمود أو الصف المظلل عندها ستفتح قائمة  -2                  
 . ( أدراج )Insert, نختار منها الأمر أوامر                       

  
                    --------------------------------------------------------------------------- 

 ثم أدرج عمود جديد Insertمستخدما" قائمة  Row3: أدرج صف جديد قبل  تمرين عملي                 
 س .مستخدما" يمين الماو C,Dيقع بين العمودين                                    

 : الحـــــــل                    
         L C on Row3→Insert→Row                                                         

                  L C on Column D→R C on any cells on column D→Insert 
 

---------------------------------------------------------------------------------------------------- 
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 Insertوهو من الأوامر الموجودة على قائمة ( ورقة عمل ):Worksheetالأمر  -3                    
 بيانات على حيث يتم أدرج ورقة عمل جديدة خالية من ال                                                                   
 شريط الأوراق وحسب طريقة العمل التالية :                                                                   

 ننقر بيسار الماوس على ورقة العمل المراد أدراج ورقة عمل جديدة قبلها على شريط الأوراق  .1-                 
 , عندها سنلاحظ أضافة ورقة عمل جديدة  Insertمن قائمة  Worksheetر نختار الأم – 2                 

 ( خالية من البيانات ) على شريط الأوراق .                        
                   ---------------------------------------------------------------------------------------- 

 
 : فعالية يمين الماوس)طريقة ثانية لأدراج ورقة عمل جديدة على شريط الأوراق ,هي (هناك             
              
 ننقر بيمين الماوس على أسم الورقة المراد أدراج ورقة عمل جديدة قبلها , عندها ستفتح قائمة أوامر . -1             

 عندها يظهر مربع حوار أنقر فيه على آيكونة  Insertنختار من قائمة الأوامر الأمر  -2              
                    Worksheet  ثم أنقر على مربعOk   عندها ستندرج ورقة عمل جديدة قبل ورقة العمل , 
 .  (1)التي حددت في خطوة                     
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 1ثم أدرج ورقة عمل جديدة تقع بين ورقة  3ورقة  أدرج ورقة عمل جديدة قبل تمرين عملي :
 وفي المطلب الثاني  Insertمطلب الأول قائمة , مستخدما" في ال  2وورقة                   
 فعالية يمين الماوس :                  

 
 الحل :

LC on Sheet 3→Insert→Worksheet                   
 

RC on Sheet 2→Insert→LC on Icon Worksheet→OK 
 
 

 لأدراج خلايا  Insert( خـلايـا ):  يوجد أمر الخلايا على قائمة أدراج Cellsالأمر  -4
 جديدة خالية من البيانات وكما يأتي :                                      

 : والخطوات العملية لذلك : (Insert)الطريقة الأولى : من قائمة أدراج     
 ر بيسار الماوس على الخلية التي ترغب بأدراج خلية جديدة حولها .أنق -1   
 بيسار الماوس . Insertمن قائمة  Cellsأنقر على الأمر  -  2                        

 من مربع الحوار الذي سيظهر أمامك ( أنظر لمربع الحوار في أدناه ) : -3                         

                                     
 

 عندها نختار أو نفعل أحد الخيارات  الأربعة التالية :                       
 (نقل الخلايا الى اليمين ) . Shift cells rightالأمر  -أمـا  أ                        
 ل ) .( نقل الخلايا الى الأسف Shift cells downالأمر -أو   ب                        
 ( صف بأكمله , أي أدراج صف بأكمله ) . Entire rowالأمـر  -أو   ج                        
 ( عمود بأكمله , أي أدراج عمود بأكمله ) . Entire columnالأمر  -أو    د                        
                       

 . OKارات الأربعة السابقة ننقر على مربع بعد أختيار أحد الخي -4                        
 

                         -------------------------------------------------------------------- 
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 وتتم كما يلي :الطريقة الثانيـة : فعالية يمين الماوس                  
 على الخلية المراد أدراج خلايا جديدة حولها . الماوسننقر بيمين  -1                   
 , عندها ستظهر نفس قائمة الحوار في الطريقة  Insertستظهر قائمة أوامر نختار منها الأمر  -2                   

 .  OKنختار أحد الخيارات الأربعة الموجودة فيها  ثم ننقر على مربع الأولى                        
                      

                     -------------------------------------------------------------------------------- 
 ثم أعمل على تنفيذ المطاليب التالية :  (A1:C3)تمرين عملي : أدخل بيانات رقمية في المدى                     

 أعمل على أدراج صف جديد قبل الصف الذي  B2من خلال وقوفك على الخلية  -1                                     
 . Insert, مستخدما" قائمة  B2تقع عليه الخلية                                           

 يقع قبل العمود  أعمل على أدراج عمود جديد B2من خلال وقوفك على الخلية  -2                                     
 , مستخدما" يمين الماوس . B2الذي تقع عليه الخلية                                           

 الى يمين  خلية جديدة تقع أعمل على أدراج B2من خلال وقوفك على الخلية  -3                                     
 . Insert, مستخدما" قائمة  B2الخلية                                           

 أعمل على أدراج خلية جديدة تقع أعلى الخلية  B2من خلال وقوفك على الخلية  - 4                                    
                                            B2 مستخدما " يمين الماوس , 

 (A1:C3)ل بيانات رقمية في المدى المذكور في السؤال الحـل : بعد أدخا                    
     1-    B2 →Isert→Cells→Entire row→OK                                                                          

                                            L C      L c    LC       Lc          LC       
               

2-    B2→Insert → Entire Column → OK                                  
                         R C      L c          LC                     LC              

 ( تترك واجب عملي في كتابة وتنفيذ الأيعاز للطالب ) . 4و  3أما الفرعين                  
            ----------------------------------------------------------------------------------------- 

 : سنتطـرق أليـه لاحقـا"المخططات أو معالج التخطيط ) : ( Chartالأمر  -5               
  
 

                       ------------------------------------------------------------------------------------- 
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 تستخدم لتنسيق البيانات في كل من الصفوف والأعمدة والخلايا :   ( Format )قـائمـة  تنسيــق                  
 ليه فيما يأتي :وأوراق العمل  وكما سنتطرق ا                                                          

 صف : حيث يتم تنسيق الصف من النواحي التالية : Rowالأمر  -1                  
                      

                                               
 : حيث يتم تنفيذ الخطوة العملية التالية : Hideالأمر أخفاء  –أ               

 يتم كما يأتي :  3مثلا" لأخفاء الصف                     
                        L C on Row3 →Format → Row → Hide                     

 : حيث يتم أظهار الصف الذي تم أخفاؤه مباشرة وكما يأتي :  Unhideالأمر أظهار  -ب            
                              Format → Row → UnHide                     

 : يستخدم هذا الأمر لتغيير أرتفاع الصف , فمثلا" لتغيير أرتفاع  ( Hight )الأمر أرتفاع  –ج              
                   Row3 تفاع أعلى من الأرتفاع الحالي بحيث يستوفي البيانات الموجودة في خلايا هذا                    الى ار 

 الصف , والخطوة العملية لذلك كما يأتي :                    
 . 3ننقر بيسار الماوس على رقم الصف  -1               
 عندها سيظهر مربع الحوار التالي : Formatمن قائمة  Hightنختار الأمر  -2               

                                           
 وحة المفاتيح الرقم الذي يمثل الأرتفاع المناسب لهذا الصف زيادة أو نقصانا" ثم ننقرنكتب من ل -3              

                   OK  في أول العمل حسب أختيارك للرقم الذي يمثل . عندها سيتغير أرتفاع الصف الذي حددته 
 الأرتفاع الجديد .                  

 
 يقة ثانية لتغيير أرتفاع الصف ,هي فعالية الماوس وكما يأتي :هناك طرمـلاحظـة :                   

 ضع الماوس بين أزرار كاشف الصف (أرقام الصفوف ) للصف المراد تغيير أرتفاعه والصف  -1                  
 الذي يليه بحيث يتغير شكل مؤشر الماوس الى سهم برأسين .                      

 لتحديد الأرتفاع المناسب المطلوب . للأعلى أو الأسفل أستمر بالضغط على الماوس مع سحبه – 2                  
 

                                   ---------------------------------------------------- 
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 وحسب ه وأظهاره حيث تغيير عرضه وأخفائ عمود : حيث يتم تنسيق العمود من Columnالأمر  -2             

 الخطوات العملية التالية لكل من الأوامر التنسيقية للأعمدة التي تحدد أو تظلل مسبقا" "                

                                                   
  Cالعمود  وة العملية التالية :مثلا" لأخفاءأخفاء : حيث يتم تنفيذ الخط Hideالأمر -أ

        L C on column C →Format → column → Hide               
       

 : حيث يتم أظهار العمود الذي تم أخفاؤه مباشرة وكما يأتي :  Unhideالأمر أظهار  -ب              
                              Format → column → UnHide                     

 , فمثلا" لتغيير عرض  خدم هذا الأمر لتغيير عرض العمود: يست ( Width )رتفاع الأمر أ –ج              
                   Column B الحالي بحيث يستوفي البيانات الموجودة في خلايا       الى عرض أكبر من العرض 
 هذا العمود والخطوة العملية لذلك كما يأتي :                   

 . B ننقر بيسار الماوس على رقم العمود -1                
 عندها سيظهر مربع الحوار التالي: Formatمن قائمة  Widthنختار الأمر  -2                

                                                 
 د زيادة أو نقصانا" ثم ننقرنكتب من لوحة المفاتيح الرقم الذي يمثل العرض المناسب لهذا العمو -3                  

                   OK  عندها سيتغير عرض العمود الذي حددته في أول العمل حسب أختيارك لأسم العمود  الذي . 
 .يمثل العرض الجديد                   

. 
 

 ا يأتي :هناك طريقة ثانية لتغيير عرض العمود ,هي فعالية الماوس وكممـلاحظـة :                   
 ضع الماوس بين أزرار كاشف العمود (عناوين الأعمدة ) للعمود المراد تغيير عرضه والعمود  -1                  

 الذي يليه ( يقع على يمينه ) بحيث يتغير شكل مؤشر الماوس الى سهم برأسين .                      
 لتحديد العرض المناسب المطلوب .  لليمين أو اليسار  أستمر بالضغط على الماوس مع – 2                  

                     ----------------------------------------------------------------------- 
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 حيث يتم تنسيق ورقة العمل من حيث أعادة تسميتها أو أخفاؤها  : Worksheetورقة العمل  -3                  
                :                              وأظهاره                       

                                                                   
 :  sheet2:مثلا" لأخفاء أخفاء : حيث يتم تنفيذ الخطوة العملية التالية  Hideالأمر -أ   

        L C on Sheet2 →Format → sheet → Hide               
       

 : حيث يتم أظهار ورقة العمل التي تم أخفاؤها مباشرة وكما يأتي :  Unhideالأمر أظهار  -ب              
                              Format → sheet → UnHide                     

  
 : حيث يتم أعادة تسمية ورقة عمل الى أسم آخر جديد  (Rename)أعادة تسمية ورقة العمل  –ج               

 الى أسم ( صحة مجتمع) Sheet2مثلا" أعد تسمية  تالية :أختياره كما في الخطوة العملية اليتم                     
 العملية التالية : نتبع الخطوات                   

        L C on Sheet2 →Format → sheet → rename→                  →Entr   
           

 هناك طريقة ثانية لأعادة تسمية ورقة العمل وهي فعالية يمين الماوس فمثلا" لأعادة تسمية                 
                 Sheet2 : الى ( صحة مجتمع ) نتبع الخطوة العملية التالية 

R C on Sheet2→Rename→Writ (              )→Enter                       
                   ------------------------------------------------------------------------------- 

 
 من  هاها من ناحية خطتنسيق بيانات الخلايا من خلال تنسيق: حيث يتم  (cells)الأمـر خلايـا  -4       
 ناحية تنسيق خلفية أو أرضية الخلايا (تعبئة أرضية الخلايا بلون  ومنFont ) خلال تبويب(           

 وحسب الخطوات العملية التالية  : (Patterns)من خلال تبويب  تختاره )          
 نحدد أو نظلل المدى أو الصف أو الصفوف أو العمود أو الأعمدة  أو ورقة العمل المراد تنسيق  - أ

 .)ب السؤال بيانات خلاياها ( حسب مطلو     
 سيظهر لنا مربع الحوار التالي : Formatمن قائمة  Cellsنختار الأمر  - ب
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 تنا أو بعض منها (حسب المطلوب في يارا(خط ) ومنه نحدد جميع أخت Fontنختار تبويب  -ج     

 السؤال) لتنسيق بيانات الخلايا من أحد أو كل النواحي التالية :          
  Arial , Arial(خط ) ( أختيارات مثلا"   Fontأسم الخط :الموجودة تحت عنوان  •

    Black   ( الخ ...... , 
 , Regular,Italic,Bold, وهي  (Font Style)عنوان  تحت : الموجود نمط الخط*

                   Bold Italic. ( 
 .لخط أ  حيث نختار الرقم المراد من خلاله تغيير حجم,  Size*حجم الخط : الموجود تحت عنوان 

 .حيث يمكن أختار أي لون لخط البيانات  (Color)*لون الخط : تحت عنوان 
  
 ستلاحظ عندها حصول جميع  . OKوبعد تحديد كل أو بعض الخيارات السابقة ننقر على مربع  
 يلات على البيانات التي حددتها في الخطوة الأولى على ورقة العمل .التعد 

          ------------------------------------------------------------------------- 
 

 ونسق بيانات الخلايا من ناحية الخط ( لون وحجم ونوع ( درجات طلابية)  تمرين عملي: أفتح ملفك السابق
 : Formatمن قائمة تنسيق ونمط الخط  )                  
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 ثم نتبع الخطوات التالية : (A1:E4)الحل : نظلل البيانات بأكملها أي المدى 
 

Format→Cells →Font    →Color     →Size    →Font    →Font style   →OK     
   LC     LC          LC     LC          any       any     any      any        

Font            Font style                                    siz               Color 
    
 لاحظ الناتج العملي للتنسيقات التي طلب في السؤال كما في الشكل أدناه :                     
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  ظ التغييرات التي ظهرت على خط البيانات للتغييرات التي حددت في السؤاللاح                    

 
 
 

 : لنفس التمرين السابق أعمل على تنسيق بيانات الخلايا فقط من ناحية ( النقـــــش )  تمرين عملي            
                          Patterns  من قائمة تنسيق Format). ( 

 ل : نظلل البيانات المراد تنسيقها من ناحية تغيير لون الخلفية أو الأرضية لها ثم نتبع الخطوات الحـــ            
 العملية التالية  :                        

Format→Cells→Patterns→any color→OK                                                         
 التي ستفتح بعد أختيارها من أمر تنسيق الخلايا : (patterns)قش لاحظ شكل نافذة الن            
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 ) كما في  Patternsمع  Fontلاحظ التغييرات التي ستطرأ على شكل البيانات التي تم تنسيقها (             
 الشكل التالي :            
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 لأجراء تنسيقات  ( tools Bar)الآيكونات الموجودة في شريط الأدوات  : يمكن أستخداممـلاحظــة    

 ه  , جعله غامقا" أو لا , جعله محاذاتالخلايا لتغيير ( حجم الخط  ,نمطه  ,نوعه  , لبيانات                   
 , جعله غامق مائل ....... الخ ) مائلا" أو لا                  

              

 
        

 حيث تستخدم الرمز والآيكونات المدرجة أشكالها ووظائفها في أدناه لأجراء التنسيقات على بيانات  
 :  Excelخلايا ورقة عمل  
 يستخدم لجعل الخط غامقا" . الرمز  •
 
 يسستخدم لجعل الخط مائلا" . الرمز  •

 
 دم لوضع خط أسفل البيانات المكتوبة .يستخ الرمز  •
 
 يستخدم لتغيير حجم الخط وذلك بالنقر على رمز السهم الموجود بجانب الرقم وأختيار  الرمز  •

 المطلوب أختياره لغرض تعديل حجم الخط . الرقم                
             

 
 توبة تلك البيانات بداخلها .يستخدم لجعل خط البيانات بمحاذاة يمين الخلايا المك  الرمز   •
 

 يستخدم لتوسيط خط البيانات المكتوبة داخل الخلايا المراد تنسيق خط بياناتها .  الرمز  •
 

 يستخدم لجعل خط البيانات بمحاذاة يسار الخلايا المكتوبة تلك البيانات بداخلها . الرمز  •
 

وذلك بالنقر على رمز  بهيستخدم لأختيار أسم الخط المراد كتابة البيانات  الرمز  •
 السهم الموجود داخل هذا الرمز ثم أختيار أسم الخط المطلوب أستخدامه .

 
يستخدم لأختيار لون الخط المطلوب أستخدامه وذلك بالنقر على رمز السهم ثم النقر على  الرمز  •

 تبويـــب   أي مربع للون المطلوب تنسيق لون خط البيانات المطلوب وهذا الرمز يقابل أو يعمل عمل
 ) من قائمة تنسيق للخلايا .  Font( خط 

 

(أي أن هذا  Excelيستخدم هذا الرمز لتعبئة خلفية أو أرضية الخلايا في ورقة عمل  الرمز  •
 ) من قائمة تنسيق للخلايا .Patternsالرمز يعمل أو يقابل تبويب (نقش 
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 المذكورة في أعلاه وذلك حسب مطلوب السؤال يمكن أستخدام واحد أو أكثر أو جميع الرموز حظـــة :ملا

 . Excel لتنسيق بيانات الخلايا في ورقة عمل                
 
 
 هو عبارة عن أظهار بيانات ورقة العمل  (chart)التخطيط :  ( Chart Wizard )معالج التخطيط  

 من أنشاء تخطيط  Excelيث يمكننا برنامج , ح في رسم بياني                                                    
 على نفس ورقة العمل حيث تكون البيانات والتخطيط على نفس                                                     
 ورقة العمل أو يمكن أنشاء التخطيط على ورقة عمل جديــــدة                                                      
 ) Chart sheetتدعى ( ورقة التخطيط                                                      

 
 أو من آيكونة معالج التخطيط  Insertالطريقة العملية لأنشاء التخطيط هي أما من قائمة أدراج                 
 أدناه : الموجودة على شريط الأدوات وسنبين ذلك كما يأتي في                

 
 والخطوات العملية لذلك كما يأتي :     Insertأمـــــــــا قائمــة أدراج                   

 
 . من خلال معالج التخطيطأو نحدد البيانات المراد رسمها  نظلل -1                 
 . الماوس بيسار Insertننقر على قائمة أدراج  – 2                 

 المفتوحة . Insertمن قائمة  Chartنختار الأمر تخطيط – 3                 
 سيظهر مربع الحوار الأول والذي يمثل الخطوة الأولى من أصل أربع خطوات أو أربع مراحل  -4                 

 (Chart wizard –step 1of 4 – chart type)( الأسم الذي يحمله مربع الحوار الأول هذا هو                    
 نوع المخطط  : ومن هذه النافذة أنقر على أي شكل من الأشكال ثم أنقر على مربع                        

 ) للعبور الى مربع الحوار التالي أو المرحلة الثانية من مراحل أنشاء مخطط . Next(التالي                      
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 من مربع الحوار الثاني ( الخطوة الثانية في أنشاء مخطط والتي تحمل أسم البيانات المصدر للتخطيط  -5              
                    Chart wizard –step 1of 4 – chart source data)  حيث يتم في هذه النافذة تحديد أيا" من ( 
 وأيا" تأخذ المحور الأفقي الصادي الموجب والذي   (Row )ني الموجب تأخذ المحور السي البيانات                    
 , وفي كل تعديل  3للعبور للنافذة رقم Next ثم ننقر على مربع التالي   (column)يمثل العمود                     
 حظ  شكل النافذة في أدناه :لمحاور البيانات سيعدل ذلك مباشرة في مربع المعاينة لهذه النافذة لا                    

 
 

                                    
              
 من مربع الحوار الثالث ( الخطوة الثالثة في أنشاء مخطط والتي تحمل أسم خيارات التخطيط   -6             

                 Chart wizard –step 3 of 4 – chart  Options) فذة على اذه الن) حيث تحتوي ه 
 عدة تبويبات كل تبويب يمثل خيار يمكن التعديل عليه وأختيار ما يطلب تنفيذه :                  

 حيث يوضع فيه عنوان للمخطط بأكمله وعنوان  titlsيحمل أسم عنوان التخطيط التبويب الأول  •
 للمحو السيني الأفقي  وعنوان للمحور الصادي العمودي .     
 ) حيث يمكن تفعيل أو عدم تفعيل تقسيمات كلا المحورين   Axesالثاني يحمل أسم ( المحاور  التبويب •

 السيني والصادي .     
 ) حيث يمكن تفعيل أو عدم تفعيل خطوط السبكة Gridlineالتبويب الثالث يحمل أسم ( خطوط الشبكة  •

 ادي .الرئيسية أو الثانوية لكلا أو أحد المحورين السيني أو الص     
) حيث يمكن أظهار أو أخفاء وسيلة الأيضاح Legendبع يحمل أسم ( وسيلة الأيضاح االتبويب الر •

 وفي 
 نختار موقع وسيلة الأيضاح  ( أعلى أو أسفل أو يمين أو يسار ) المخطط المرسوم حالة تفعيل أظهارها     
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 وفي كل أختيار نلاحظ المعاينة مباشرة داخل النافذة .     
 ) حيث يتم تفعيل أو عدم تفعيل أما أرقام Data Labelsويب الخامس : يحمل أسم (علامات البيانات التب •

 القيم أو مسميات المحور السيني أو مسميات المحور الصادي على شكل المخطط الذي أخترناه من     
 . 1الخطوة  رقم     
 حيث يمكن من خلاله تفعيل أو عدم ) Data Tableالتبويب السادس : ويحمل أسم ( منضدة البيانات  •

 أضافة أو عدم أضافة  جدول البيانات أسفل المخطط المرسوم تفعيل     
 

 للعبور الى  Nextوبعد تنفيذ كل التبويبات الستة أعلاه أو أي عدد منها يتم النقر على مربع التالي     
 المرحلة الأخيرة ( مربع الحوار الرابع ) .    

                     
 

 من مربع الحوار الرابع ( الخطوة الرابعة في أنشاء مخطط والتي تحمل أسم موقع التخطيط    -           7     
                      Chart wizard –step 4 of 4 – chart  Location )  ( حيث يتم أختيار موقع المخطط 
 أو نضع المخطط على أي ورقة عمل نختارها  ( As new sheet )أما على ورقة عمل جديدة                      
 ... الخ . وبعد أختيار أحد الخيارين السابقين ننقر على مربـــــــــــع   Sheet2أو  Sheet1أما                      
 أخترتها في مراحل  ) عندها سيظهر المخطط الذي أخترته بكافة الأختيارات التي Finish( أنهاء                      
 الرسم الأربعة . لاحظ شكل نافذة المرحلة الرابعة في أدناه :                      
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 وذلك بالنقر على آيكونة   Tools Bar: من شريط الأدوات الطريقة الثانية  لأدراج المخططات هي                

 ( بعد تحديد أو تظليل البيانات المراد تحويلها الى مخطط ) عندها تظهر نفس  معالج المخططات                 
 مراحل الرسم .مربعات الحوار الأربعة السابقة  وننفذ كافة التبويبات المراد تفعيلها في كل مرحلة من                 

          
             

 أفتح ملفك السابق ( درجات طلابية) وأعمل على رسم هذه البيانات موضخا" وباستخدام  تمرين عملي :          
 أحد أنواع المخططات العلاقة بين أسماء الطلبة ( ولتكن مرسومة على المحور السيني )                            

 والمواد الدراسية ( ولتكن مرسومة على المحور الصادي الموجب )  مستخدما" قائمة أدراج                            
                             Insert : 

                                Chartثم الأمر    Insertالحـــل : نظلل أسماء ودرجات الطلاب بعد فتح الملف ثم ننقر على قائمة             
                             

                      

 
 
 

 مل وكما عحل الأربعة سيتم تنفيذ وظهور رسم المخطط على نفس ورقة الوبعد تنفيذ وعبور كافة المرا             
 :يأتي                
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                  ----------------------------------------------------------------------------------------- 
 

 في الأطار المحيط بعد ظهور المخطط يمكن النقر بيسار الماوس لتظهر المقابض  -1 مـلاحظــات :                
 تصغير حجم المخطط بالشكل الذي نريده .للمخطط لنتمكن من تكبير و                                     

 
 يمكن النقر بيمين الماوس داخل أطار رسم المخطط عندها ستظهر قائمة أوامر يمكن  -2                                 

 ر لون من خلالها تنفيذ العديد من الخيارات منها تنسيق مساحة المخطط ( أي أختيا                                      
           ) وتنفيذ ودخول أي مرحلة من مراحل Format chart Areaلمساحة المخطط                                       
 أو كل بعض خيارات تلك النافذة أو المرحلة ثم النقر  الرسم الأربعة لتغيير بعض                                      

 كم يمكن نسخ أو قص أو مسح المخطط أو عمل أطار  OKعلى مربع موافق                                      
 :)  chart window( خيار  للمخطط وجعله نافذة                                      

                                                                          
                          ----------------------------------------------------------------------------- 
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 أعمل على  وظهوره على ورقة العمل تمرين عملي : بعد أن رسمت بيانات ملفك ( درجات طلابية )                   

 بقية كافة الخيارات التي ستظهر على قائمة ونوع المخطط و تغيير حجم المخطط                                       
 . طط الذي رسمته خعلى المالأوامر التي ستفتح                                      

 
                      ---------------------------------------------------------------------------------- 

 
 

 ادي عشر الى  الأسبوع العشرين الأسبوع الح               
 
 هو عبارة عن نظام متكامل من البرامج الأحصائية المختلفة يتم من :  SPSSالبرنامج الأحصائي  

 خلاله قراءة البيانات وتحليلها وعرض وطباعة البيانات والمعلومات                                       
 الناتجة  من خلال هذا التحليل .                                      

 : SPSSتشغيل برنامج  
 ( وبعد تنصيب   Windowsمن خلال شاشة  SPSS يتم تشغيل برنامج                               
 البرنامج) كما يأتي :                               

                                          Start→programs→Spss for windows→spss 10.0  
 

 : تتكون شاشة  أو نافذة البرنامج على المكونات والأشرطة التالية : SPSSمكونات شاشة 
  

 :وهو العنوان الذي يتصدر كل نافذة والذي يحتوي في أقصى اليمين على  Title Barشريط العنوان  – 1  
 ثة المعهودة لكل نافذة ( الأغلاق والتكبير والتصغير             الثلاالأزرار                                           

 . SPSSوالأغلاق المؤقت ) وفي أقصى اليسار على أسم النافذة                                            
 
 ن :  ويحتوي على العديد من القوائم والتي تمثل كل منها قائمة مmenu barشريط القوائم الرئيسي  -2 

 الأوامر الرئيسية الخاصة بالتعامل مع هذه النافذة ومنها :                                                  
                                                               )(File, Edit, View,Data,….             

 
 هذا الشريط على آيكونات تعمل عمل أحد الأوامر : ويحتوي   ( standard Bar)الشريط القياسي  -3

 الخاصة بأحد قوائم الشريط السابق .                                                     
 
 : ويكتب في هذا الشريط أسم المتغير ( العمود ) ورقم السطر ( الصف ) (State Bar)شريط الحالة  -4

 . ( Data View )في كل خلية موجود عليها المؤشر في نافذة                                          
 
 متغير ( أي يتكون الجدول أو متن (Varible)والأعمدة  Caseالجدول الخاص بالصفوف (الحالات)  -5

 ) مع عمود ( متغير caseمن خلايا تمثل المكان الذي نتج عن تقاطع حالة (صف  SPSSنافذة      
     Varible (   . 

 
 نافذة  (Data View)مع وجود أسمين لنافذتين هما  أشرطة التمرير ( نحو اليمين ونحو اليسار )  -6

 عرض المتغيرات . ( Variable View)عرض البيانات ونافذة      
      ------------------------------------------------------------------------------------ 
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 بينما يسمى الصف في شاشة  ( variable)بالمتغير  SPSSيسمى العمود في شاشة  -1: حظة ملا      

                        SPSS  بالحالة(Case ) . 
 فأن هذا النظام سيفتح تلقائيا" على نافذة شاشة عرض البيانات  SPSSعند فتح شاشة  -2                    

                        (Data View ) . 
 ننتقل الى نافذة عرض  SPSSلغرض أدخال عناوين البيانات ومواصفاتها على شاشة  -3                     

 في  Variable Viewوذلك بالنقر على شاشة  ( Variable View)المتغيرات                           
 .  SPSSأسفل نافذة                           

       ---------------------------------------------------------------------------------------- 
 :( ورقة ملحقة )  SPSSلاحظ شكل نافذة برنامج          

 
 
  

 : SPSSكيفية أدخال البيانات في نظام     
 

 يرات ثم الأنتقال  عرض المتغ  ( Variable View )من خلال شاشة نافذة يتم أدخال مواصفات البيانات 
 فمثلا" لأدخال عناوين مثل اللأسم (Data View)معلومات  البيانات على شاشة عرض البيانات  لأدخال

(name)  والعمر(Age)  واللون(color)  والوظيفة(Job) : الخ من أسماء العناوين للبيانات ...... 
   
نكتب في الخلية الأولى التي تقع في                        حيث  (Variable View)ننتقل الى شاشة عرض المتغيرات  -1 

الأسم ثم نكمل مواصفات الأسم على هذا   (name)الصف الأول والعمود الأول نكتب أسفل عنوان كلمة 
وفي هذا الحقل أو هذه الخلية نحدد نوع  (Type)الصف الأول العمود الثاني والذي يحمل عنوان نوع 

عددي وننتقل الى العمود الثالث لنفس الصف الأول وتحت عنوان         أم  (String)البيان هل هو نصي 
عمود الخاص بأسماء حيث يوجد سهمان صعودا" أو نزولا" لزيادة أو نقصان عرض ال (Width)العمود 

 البيانات وهكذا الى أن نكمل بقية مواصفات العنوان الأول .
 
 وذلك بالنقر على أسم هذه النافذة الموجودة أسفل   (Data View)ثم ننتقل الى شاشة عرض البيانات  -2

 ا" في شاشة عرض البياناتالذي حددنا مواصفاته سابق (name)لكتابة أسماء العنوان  SPSSبرنامج      
 كما نكتب أعمار الأشخاص تحت عنوان العمر بالتتابع وهكذا مع ملاحظة وبعد أدخال  (1)في خطوة     
 . Excelمن لوحة المفاتيح لتثبيت المعلومة كما في برنامج   Enterغط على مفتاح كل بيان نض    

 
 ------------------------------------------------------------------------------------------ 
 
 نتبع الخطوات العملية التالية :حفظ البيانات المدخلة لأول مرة :   

                                 File →Save as →write File name→Save      
 
 

 نتبع الخطوات العملية التالية :  حفظ البيانات بعد أجراء تعديل عليها :   
File →Save                                       ولا بد أن تكون شاشة محرر البيانات 

                                                 (Data View ) هي الشاشة الفعالة . 
 .)متشابهان  Excel, SPSSبعد تعديل  للبيانات في كل من  ( لآحظ أن  كلا الأمرين حفظ بأسم وحفظ    
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( لاحظ أختلاف طريقة العمل في :  نتبع الخطوات العملية التالية: أنشاء أو تكوين ملف بيانات جديد 

SPSS  عنها في برنامجExcel ( 
      File → New → Data                                                

  
 : نتبع الخطوات النتالية : فتح ملف بيانات مخزون مسبقا"

File → Open →Data → L C on file name → OK           عندها سيفتح الملف الذي أخترنا 
  فتحه .           

 ) Excelعنها في برنامج  SPSSالعمل في ( لاحظ أختلاف طريقة              
 

     ----------------------------------------------------------------------------------- 
 

 نتبع الخطوات العملية التالية : ( Go to Case ) مباشرة : (case)الأنتقال الى حالة      
  

 .  Go to Caseننقر على الأمر    Dataمن قائمة  -1    
 رقم الحالة  Case numberأكتب داخل مربع رقم الحالة  Case  numberسيظهر مربع جوار  -2               

 .  OK( الصف ) الذي تود الأنتقال اليه , ثم أنقر على مربع                  
 

             Data→Go to Case→write number Case →OK                         
 

 عندها سيتم الأنتقال مباشرة الى رقم الحالة الذي حددته في مربع رقم الحالة .                    
                  -------------------------------------------------------------------------------------- 
 Editالمراد نسخها أو نقلها ثم ننقر على قائمة  اناتنحدد أو نظلل البينقل ونسخ البيانات :                  

 لصققة قص ثم نحدد بداية منط Cutنسخ أو الأمر   copyثم نختار الأمر                                            
 . Pastثم نختار أمر لصق   Editالبيانات ثم ننقر على قائمة                                            

 ) . Excel , SPSS( لاحظ تشابه كل من أمري النسخ والقص في كلا البرنامجين                 
            ------------------------------------------------------------------------------------- 
 العمود أو مجموعة المتغيرات نحدد المتغير أو:  Delete Variableحذف متغير ( عمود )                  

 . Clearثم نختار الأمر  Editالمراد حذفها ثم ننقر على قائمة                   
                         LC on name Variable →Edit→Clear                          

                    ---------------------------------------------------------------------------------- 
 نحدد أو نظلل الحالة أو الحالات المراد :  Case  :Delete Caseحذف الحالة ( الصف )                    

 .  Clearثم نختار الأمر  Editحذفها ثم ننقر على قائمة                                                
                         LC on name Case →Edit→Clear                          

 
 المتغيرات والصفوفهو امر حذف ) SPSS  )Clear( لاحظ أن أمر الحذف في برنامج                  

 ) Excelوالذي يقابل أمر المسح أو التنظيف في برنامج                    
                      

                 ------------------------------------------------------------------------------------------ 
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 : نتبع الخطوات التالية :   (Insert Case)أدراج حالة                             
 قبله .نحدد او نظلل الحالة ( الصف ) المراد أدراج حالة جديدة تقع  -1                        
 ظهر صف فارغ جديد يقع فوقسي Insert Caseنختار الأمر  ثم Dataننقر على قائمة  – 2                        

 .) (1الحالة التي حددت في خطوة                               
                  L c on case name→Data→Insert Case                         

                       ------------------------------------------------------------------------------- 
 : نتبع الخطوات التالية :(Insert Variable)أدراج متغير                       
 ع قبله .( العمود ) المراد أدراج متغير جديد تق  رنحدد او نظلل المتغي -1                         

 سيظهر متغير فارغ جديد يقع قبل Insert variableنختار الأمر  ثم Dataننقر على قائمة  – 2                        
 بعطي أسما" تلقائيا" SPSS) علما" أن برنامج  (1المتغير أو العمود الذي حدد في خطوة                               

 يمكن تغيير الأسم  أن أردت ذلك . (VAR 0001 )للمتغير الجديد يحمل أسم                               
 
  Data→Insert  Variable                            →L C on Variable name 
 

                         --------------------------------------------------------------------------------- 
          

 SPSSوأدراج الحالة في  Excelملاحظـــــة : لاحظ الفرق الكبير في أمري أدراج صف في                   
 . SPSSوأدراج متغيرفي  Excelوأمر أدراج عمود في                                    
                                   -------------------------------------------------------------------- 

 
 : نتبع الخطوات العملية التالية :SPSS (Fonts)تغيير نمط خط البيانات في                     

 
 نحدد البيانات المراد تغيير نمط خطها ( نظلل ) . -1                     
 . Fontثم ننقر على مربع خط  Select ثم نختار الأمر Viewننقر على قائمة  -2                     
 ونمط الخط  Font typeمانريد أن نغيره من نوع الخط  رمن مربع حوار خط نغي -3                     

                       Style Font    وحجم الخطSize Font  ولون الخطColor Font    وفي كل أختيار نلاحظ 
 ع المعاينة . مرب                        

 .  OKننقر على مربع  -4                      
 
 L C on Range ( cases)→View→Select→Font→L c on any (type,size,..)→OK          
   

         --------------------------------------------------------------------------------------------- 
 

 ونمط تغيير الخط في برنامج Excelـة : لاحظ الفرق الكبير في أمر تغيير نمط الخط  في برنامج ملاحظـ            
                                   SPSS . 

                       ------------------------------------------------------------------------------------- 
 

                      
 (  تـــــــم بحمـــد اللـــــه تعالـــــــــــــــــــــى )                                    
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